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Copyright

GreatCut uses NLog

NLog is a free logging platform for .NET, Silverlight and Windows Phone with rich log

routing and management capabilities. It makes it easy to produce and manage high-quality

logs for your application regardless of its size or complexity.

Copyright (c) 2004-2011 Jaroslaw Kowalski

All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are

permitted provided that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of

conditions and the following disclaimer.

* Redistributions in binary form must reproduce the above copyright notice, this list of

conditions and the following disclaimer in the documentation and/or other materials

provided with the distribution.

* Neither the name of Jaroslaw Kowalski nor the names of its contributors may be used to

endorse or promote products derived from this software without specific prior written

permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND

CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES,

INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF

MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE

DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS

BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR

CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT

OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR

BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF

LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING

NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS

SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
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1 Preface

GreatCut 4™ is add-on software for cutting vinyl from CorelDRAW™, Illustrator, Freehand

and AutoCAD. On account of their wide range of graphic possibilities these illustration

programs are eminently suited to producing high-quality drawings that can easily be

printed using powerful printer drivers.

For most professional requirements GreatCut 4 is the best choice, as it enhances your

illustration program with high-end signmaking tools such as automatic print & cut with

contour lines. This tool supports Accu Aligning System (AAS) with Puma III and Jaguar IV

series.

Its sophisticated welding functions allow multi-colored cuttings. Its Inline/Outline tool

outlines texts - both tools can only else be found in specialized cutting programs. So

GreatCut 4 is the ideal plug-in for vinyl signage, screen printing and copy shops, which

need to convert logos and all kinds of vector graphics into cutable data.

1.1 What GreatCut 4 Can Do?

GreatCut 4 is able to work with GCC cutters and adapt to their particular

features.

•   

GreatCut 4 automatically converts lines to cutable contours.•   

Cutting by color and precise mounting using register marks•   

Color welding: user-defined color overlaps and screen-printing overlaps with

user-defined color sequence.

•   

Cutting preview of vinyl width and display of the amount of vinyl used.•   

Positioning, resizing, duplicating, etc. of objects.•   

GreatCut 4 evaluates the data produced by the host program and prepares it for

cutting on GCC cutters

•   

GreatCut 4 can cut even extremely large drawings without any difficulty. You

can resize and segment your drawings to any scale you wish, no matter what

the size of the drawing in the host program.

•   

If the drawing is too wide for your cutter, it will be automatically sectioned, i.e.

divided so that your cutter can cut it.

•   

You can set up default values for printing and speed for different materials.

These values can be stored in a material database for reuse at any time.

•   

While your cutter is cutting, you can continue working with CorelDRAW or any

other Windows program. The cutter works in the background.

•   

.
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2 Quickstart and Installation

2.1 Quickstart

2.1.1 How to Install GreatCut?

2.1.1.1 Step 1: Connection

Cutter control via USB

Install cutter USB drivers, which were delivered by GCC. Please use the instructions given

by cutter manual.

Cutter control via COM port (serial)

Make sure, that cutter and serial Windows port are configured identically.

You´ll find this port configuration in the system Control Panel under:

System/Hardware/Device Manager/Ports/Communications Port. Select via double click the

respective port (e. g. COM1) and activate Port Settings.

Default settings are: Bits per second: 9600 or 19200, Data bits: 8, Parity: None, Stop bits:

1, Flow control: Hardware

Check also Resources: COM 1: I/O Range 03F8 and IRQ 4 and COM 2:

I/O Range 02F8 and IRQ 3 respectively

2.1.1.2 Step 2: Installation

Start the GreatCut 4 installation by double clicking greatcut.exe.

5



Fig. 2.1-1: GreatCut 4 setup

Note: Installation process is done again for each selected application.

2.1.1 How to Install GreatCut?
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Fig. 2.1-2: Software License Agreement

In this dialog the installation folder for GreatCut 4 is chosen. By default the folder

C:\Program Files\GCC\GreatCut 4 is suggested.

2.1.1 How to Install GreatCut?
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Fig. 2.1-3: Selection of destination folder

Hint: To install additional drivers select custom setup.

2.1.1 How to Install GreatCut?

8



Fig. 2.1-4: Selection of setup type

Default program folder in the start menu is GCC\GreatCut 4.

2.1.1 How to Install GreatCut?
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Fig. 2.1-5: Position in start menu

2.1.2 Enter License Data

You´ll find your personal serial number on the inner left hand side of your manual.

Alternatively you´ll find your data on your invoice or you got it by email.

Important! All license data must be entered exactly how printed!

2.1.2.1 Use .ecf file: Recommended, if license data was sent via email.

In the eMail with license data you´ll find an attached file with the extension .ecf.

A double click on this file will license your software automatically!

2.1.2 Enter License Data
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Fig. 2.1-6: Start window with invalid code

By clicking "License..." button following dialog is opened.

Fig. 2.1-7: Option for first installation of GreatCut 4

2.1.2 Enter License Data
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Fig. 2.1-8: These fields have to be filled with license data

2.1.2 Enter License Data
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2.2 The Cut Marks Toolbar

All object functions of the Cut Marks Toolbar act directly on the host program's

(CorelDRAW or Illustrator) objects. This extends host program's functionality with these

tools so that the whole Print & Cut workflow can be prepared and given out with

CorelDRAW or Illustrator. Of course, GreatCut 4 can be started without a host program.

The described tools are also available in the standalone version.

Important note: The functionality described here is only possible with CorelDRAW

X3 to X8 and Illustrator CS3 to CS6 and CC! Implementation in older CorelDRAW

and Illustrator versions: please refer to 2.3: Autoexport - Scripts

2.2.1 The Cut Marks Workflow

The following graphic illustrates the Print & Cut workflow (Cut Marks Workflow) inside the

host program (CorelDRAW or Illustrator).

Starting point of the Cut Marks Workflow is a bitmap, which gets contoured as first step. In

the second step multiple copies are generated. In the next step suitable register marks are

placed around the copies.

This Job must be printed on a suitable printer and is finished with a cutting plotter (cutter)

equipped with an optical sensor. The so called registration - Cut Marks recognition -

corrects the prints deviations and the job is cutted. The results of this process are exactly

cutted copies in any number and size.

2.2.2 The Cut Marks Toolbar in CorelDRAW X3-X8

Fig. 2.2-1: Toolbar in CorelDRAW X3-X8

The buttons were so arranged from left to right that the Cut Marks Workflow can be

performed perfectly.

2.2 The Cut Marks Toolbar
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2.2.3 The File Menu Entries in Illustrator CS3-CS6, CC

Fig. 2.2-2: Illustrator sub menu GreatCut 4

The menu entries are arranged from top to bottom in a way that the Cut Marks Workflow

can be performed perfectly.

2.2.3.1 Buttons of the Cut Marks Toolbar

Important note: The following descriptions are valid also for Illustrator!

1 The Create Contour Button

Fig. 2.2-3: Create Contour Icon

please refer to 7.8: The Contour (Line) Function

2 The Multi Copy Button

Fig. 2.2-4: Multi Copy Icon

please refer to 6.4: The Object Parameter Toolbar

3 The Set Jog Marks Button

Fig. 2.2-5: Set Jog Marks Icon

4 The Cut Button

Fig. 2.2-6: Cut Icon

2.2.3 The File Menu Entries in Illustrator CS3-CS6, CC
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please refer to 3.5: Cutting - Milling - Creasing - Drawing …

5 The Direct Cutting Button

Fig. 2.2-7: Direct cutting Icon

Activating this button ensures that no window appears before the data output. The output

data is sent directly to the connected device.

6 The Export Button

Fig. 2.2-8: Export Icon

Activating this button ensures that the selected data is exported into the specified folder

(see Settings dialog).

Note: In CorelDRAW, the data are saved in the CMX file format, otherwise in PDF

format.

7 The Create Outline Button

Fig. 2.2-9: Create Outline Icon

please refer to 7.2: The Outline Function

8 The Create Outline Layer Button

Fig. 2.2-10: Create Outline Layer Icon

After activating this button the object attribute is changed and a spot color for the selected

contour, which was not generated with the GreatCut 4 button, is assigned.

9 The Welding Button

Fig. 2.2-11: Welding Icon

Activating this button welds the selected objects.

2.2.3 The File Menu Entries in Illustrator CS3-CS6, CC
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please refer to 7.6: The Welding Tool

10 The Settings Button

Fig. 2.2-12: Settings Icon

A click on the Settings Button opens the Settings window.

2.2.3.2 The Settings Dialog

Eurosystems Software Field

Fig. 2.2-13: 2 Point Icon

A click on the 2 point button enables the selected program and allows changing of Settings

parameters.

Jog Marks Field

Fig. 2.2-14: 2 Point Icon

A click on the 2 point button opens the Setup - Jog Marks dialog. It allows the selection of

the appropriate cut marks for the plotter, in case your cutter has an optical sensor and its

2.2.3 The File Menu Entries in Illustrator CS3-CS6, CC

16



driver supports this feature.

Export Field

Fig. 2.2-15: 2 Point Icon

A click on the 2-point button opens the Search folder dialog. It allows the selection of the

export folder where the exported file should be saved.

Name of Layer for Jog Marks Option

This option enables the assignment of an individual layer name. Then this jog marks layer

can be identified at any time and the jog marks can be selected. Preset is Regmark.

Name of Layer for Outline Option

This option enables the assignment of an individual layer name. Then this outline layer

can be identified at any time and the outline(s) can be selected. Preset is Outline.

The Output Parameters… Button

Activating the Output Parameters button opens the cutting dialog and allows you to set

individual settings when cutting.

Show Always Contour and Outline Settings Option

If this option is enabled then the dialogs which allow the parameter definition are always

displayed, when the appropriate button was activated.

2.2.3 The File Menu Entries in Illustrator CS3-CS6, CC
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During the Cut Process only Transfer 'Regmark' and 'Outline' layer Option

If this option is activated then only the objects are transferred to GreatCut 4 to which this

two layers have been assigned: regardless of the current selection!

Create New File While Cutting Option

If this option is enabled then after pressing the Cut button a new window in GreatCut 4 is

opened and all or all selected objects are copied into the new window.

Open Output Dialog While Cutting Option

If this option is activated then after pressing the Cut button the Output dialog is opened.

2.3 Autoexport - Scripts

Autoexport means that data from external programs (CorelDRAW, CorelDesigner,

Illustrator, Freehand, Inkscape, InDesign or AutoCAD) are imported automatically into

GreatCut - quasi at the push of a button. To do this the scripts are either integrated into

the external program's menu structure or toolbar.

2.3.1 Corun Installer

With the Corun Installer you can install GreatCut the plugins. In the Name column all host

programs are listed, in which the plug-ins can be implemented. In the Plugin path column

is displayed in which the folder the plug-in files are located after installation. In the

Eurosystem software list all programs are listed that have a plug-in functionality. Select the

appropriate program from the list. Activating the Install button starts the process.

Note: The Corun Installer is required if the host application was installed BEFORE
the EUROSYSTEMS program or if plugins must be re-installed.

2.3 Autoexport - Scripts
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Fig. 2.3-1: Corun Installer dialog window with detected host programs and path indicators.

2.3.2 Insert GreatCut Icon in CorelDRAW Toolbar

2.3.2.1 CorelDRAW X3-X8

Indication: CorelDRAW must be installed with the option “Visual Basic for
Application”.

This option can be installed as follows:

2.3.1 Corun Installer
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Insert CorelDRAW medium into the drive / start setup / select type of installation „Custom
setup”. If already a CorelDRAW-version is installed on your computer, first select „user

defined setup” and then „Custom setup”.

In the dialog that opens now, double click on main applications or one click on the

Plus-field. Here, double click on productivity support and activate the option „Visual

Basic for Application”. After the installation of GreatCut you have to link the GreatCut

Script with the toolbar.

Select the menu Tools / Customization•   

Select the option Workspace / Customization / Commands  in the left option

bar

•   

Right next to the option bar, click once on File and select Macros and drag

Corun... or Cocut... to the toolbar of CorelDRAW.

•   

Activate the tab Appearance. Here, press the Import-button and select any

symbol.

•   

Select the option Workspace/Customization/Command Bars  in the left option

bar .

•   

Change the name of the toolbar „New ToolBar 1” to GreatCut.•   

Click on OK.•   

If you now mark one or several objects and click on the thus created icon, the objects are

passed on to GreatCut and can be plotted.

2.3.3 GreatCut Script in Adobe Illustrator 8-10, CS-CS6, CC

GreatCut is in the file menu underneath the menu item export.

How does the transfer of data from Illustrator 8, 9, 10, CS, CS2, CS3, CS4, CS5, CS6,
CC to GreatCut take place?

Start GreatCut from the file  menu. If the objects are marked, only the marked objects are

passed on to GreatCut. If also texts are passed on they will automatically be converted to

curves.

Indication: If no objects are marked, GreatCut is not active!

Indication: Special process color fills are not passed on.

2.3.4 GreatCut Script in AutoCAD

2.3.4.1 Menu File for AutoCAD 2000(i), 2002-2015, 2002LT-2015LT

In the menu Extras select the menu item adjust menus.

(Indication: Alternatively you can also open the dialog via the command 

_menuload)

•   

In the dialog that now opens select the tab menu groups and press the browse

button.

•   

2.3.2 Insert GreatCut Icon in CorelDRAW Toolbar
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The file selection dialog opens. Change the file ending to *.mnu in this dialog.•   

Select the file corun.mnu  and close the dialog.•   

Now press the Load button and confirm the inquiry dialog with ok.•   

The GreatCut menu is now loaded.•   

Now change the menu bar dialog in the upper tab. In the menu group select

GreatCut Plot and insert it into the desired place in the AutoCAD menu.

•   

2.3.4.2 Menu File for AutoCAD LT 98 And R14

In the menu Extras select the menu item Adjust/Menus.•   

In the dialog that now opens press the browse button.•   

The file selection dialog opens. Change the file ending to *.mnu in this dialog.•   

Select the file corun.mnu  and close the dialog.•   

Now press the Load button and confirm the inquiry dialog with ok.•   

The GreatCut-menu is now loaded.•   

Now change to the menu bar dialog in the upper tab. In the menu group select

GreatCut Plot and insert it into the desired place in the AutoCAD menu.

•   

In the menu file  select the menu item printer installation.•   

In the dialog that now opens press the open  button and select the file

cocutlt98.pc2 (LT98) respectively cocutr14pc2 (R14).

•   

Close the dialog.•   

Start now the print-job by activating the menu item print  in the file menu in

order to do following settings: activate the button Plot in file, set the scale

factor to 1:1 and the unit to mm.

•   

In the menu is now GreatCut entry and in the toolbars GreatCut toolbar was added.

Important: Be careful that at the first output the checkbox "plot to file" is activated.

With this procedure, all graph elements are passed on. The change-pen commands

are interpreted from the PLT file so that the 8 layers are separable. AutoCAD does

not plot with Arcs, which means that all elements are resolved in lines and dots are

interpreted as bores.

Indication: If DXF is used, you have to press twice the ENTER button after the

selection of the object as the execution of the macro menu is aborted by the object
selection. At the passing on via DXF the dimensions and texts are not passed on

but it is possible to select and output them. The curves are not converted to lines
but the Splines or Arcs in the DXF file are converted to Bezier curves. The layer

amount is not limited to 8.

In the startup group of Windows a link to the program autoimp.exe is installed during the

installation with which the passing on of files to GreatCut is realized. If autoimp.exe is

started an icon is shown in the system tray (lower right corner of the screen). Double

clicking on the icon ends the program.

Attention: If the icon is switched off the transfer to GreatCut does not work anymore!

Via Start / All Programs / Startup / Auto Import for GreatCut it can be started again.

2.3.4 GreatCut Script in AutoCAD
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Indication: During the installation you have to pay attention that GreatCut is always
installed for the last used AutoCAD version if several AutoCAD versions are

installed on your computer.

2.4 Selection of The Device Driver

Please, select first your output device from the list driver. In the field name of device  the

identical name for the selected device that is shown in the cutting dialog appears. This

name can be changed individually in this field. After the selection of the driver please

select - in the area type of connection - the device type with which the device is

connected to the computer.

Tip: If the driver you search for is not in the list you can try another driver from the

same manufacturer.

Fig. 2.4-1: Dialog for the selection of the device driver

Detailed information for the setting of the local interface is here: please refer to 3.5:
Cutting - Milling - Creasing - Drawing …

2.4 Selection of The Device Driver
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3 How to work with GreatCut

3.1 Desktop and Working Sheet

3.1.1 I. Desktop

The so-called Desktop means the whole visible program window including Toolbars,
Working Sheet and Desktop background.

Note: On the background can be placed any desired number of objects. The size of

the background is limited only by the resources of your computer. Thus the layout

can be done basically in 1:1 scale.

Fig. 3.1-1: Desktop with working sheet (here: gray), Background (here: white), Toolbars,

Sidebar, Rulers, Statusbar

3.1.2 II. Working Area

The so-called Working Area is a sub area of the GreatCut desktop. The working sheet is -

as a rule - the same format that is given out later on your device. Besides the known

DIN formats arbitrary formats can be applied e. g. different sign sizes.
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Note: The working area is used primarily for guidance. The format of the working
area has no influence on the output on a connected device. The output preview

window displays what is given out.

please refer to 3.5: Cutting - Milling - Creasing - Drawing …

Fig. 3.1-2: Working Sheet Setup

3.1.2.1 Format

Name

In this field the name of the new format is entered resp. that of the selected format

Width

Hereby, the width of a format is assigned.

3.1.2 II. Working Area
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Height

Hereby, the height of a format is assigned.

Rescale to Objects Option

This option fits the working sheet to the objects which are located on the desktop

background.

Read Out Connected Device Button

A connected device can - if the read out command can be processed by the devices'

controller - define the size of the working sheet.

3.1.2.2 Margins

Left, Right, Top, Bottom

In this 4 field the distance from the margins to the sheet edge is defined.

Note: Also negative values are allowed.

Display Leaf Margins

This option shows margins as dotted aid lines above the working sheet.

3.1.2.3 Alignment

Portrait

This option defines, if the format is displayed as portrait.

Landscape

This option defines if the format is displayed as landscape.

Rotate Objects Option

This option defines, if the objects which are located on the working sheet or desktop

background, are also rotated when the alignment is changed.

3.1.2.4 Preview

In this area Working Sheet, Background Color, Background Image, Proportion and

Alignment of the working sheet is displayed.

3.1.2 II. Working Area
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3.1.2.5 Color

Working Sheet

This option defines the color of the working sheet.

Background

This option defines the color of the desktop background. 

3.1.2.6 List of Formats

Rotate Objects Option

This option scales, decreases or increases - all objects on the desktop background

proportional to the values of the changed format of the working sheet. 

Standard* Button

The Standard button marks the selected format in the list of formats and saves the

selection. With each new job this format is preselected.

Image Option

This option shows the selected bitmap on the working sheet.

 Button

The  button opens a window, in order to search or insert the desired image.

3.2 Functional Principle of The GreatCut Software

3.2.1 Job Preparation

3.1.2 II. Working Area
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3.2.1.1 Import

With this command the graphics that have not been saved in the GreatCut-job-format are

transfered to the working surface.

The functionality of this dialog box corresponds to the open file command. Differences are

only due to the possibility to change the size of the data to be imported by means of the

parameter X- and Y-factor. The desired file is chosen respectively specified via the name

of file, type of file and directories (search in).

Fig. 3.2-1: Import window with preview

With the preview window in the import dialog all following formats can be displayed.

*.ai/eps, *.pcx, *.jtp, *.tif, *.bmp, *.wmf, *.emf, *.dxf, *.gif, *.hpgl, *.gtp, *.ik

Indication: With text files (*.txt) the preview window is switched off.

3.2.1.1.1 Import Presettings

For many import operations, constraints can be defined to be taken into account before,

during or after importing the data. Constraints can effect the DXF or HPGL import or all

import operations.

Also for export constraints are definable in this window. Thus, a special option on job files

can be activated, for example, the PDF export. The constraints are extensively recorded

3.2.1 Job Preparation
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in the following article. please refer to 4.6.1.5: The Filter Setup

Fig. 3.2-2: Determination of constraints with import of data

3.2.1 Job Preparation
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3.2.1.1.2 PDF Import

3.2.1.1.2.1 Additional Options

Fig. 3.2-3: Options concerning import of data

Integrated Job File

The Extract Button

Enabling the Extract ... button ensures, that the import function loads the integrated job

file on the desktop, while extracting the PDF file.

Note:  A prerequisite for this is that when you export the appropriate option in the

preferences (see above) was made.

Raster Options

Import as Bitmap Option

If the Import as Bitmap option is enabled, then all vectors will be rastered into a bitmap

before the import.

3.2.1 Job Preparation
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Resolution

The value in dpi

Element Selection

Ignore Images Option

If the Ignore Images option is enabled, then no images will be imported.

Ignore Text Option

If the Ignore Text option is enabled, then no texts will be imported.

Page Selection

In the input field the page number can be entered, which should be imported.

All Pages Option

If the All Pages option is enabled, then all pages of the document will be imported.

Search in

In the row Search in the path can be set that shall be searched.

File name

If the file name is know it can be entered into this field

Type of file

Here, you have to choose the format of the file to be imported in order to activate the

corresponding import filter

Preview

The activation of this option draws a preview of the file content to the left preview window

Insert at Position (0,0)

This option inserts the objects at the 0 (zero) position of the GreatCut-working surface.

X Factor, Y Factor

With these two factors the data can be scaled (increased or decreased) during the import.

The scale can be proportional or unproportional.

3.2.1 Job Preparation
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3.2.2 Tool Assignment Via Layer

Tools which are provided from an output device are pre-defined in the device driver. The

tool selection is done with the output dialog of the Mode / Tool list field.

Fig. 3.2-4: Tools and toos parameter which were defined in the device driver

3.2.2.1 Define Layer Assignment

What tool is located in which layer - that is necessary to define the order of execution - will

be assigned in the layer settings window. A click with the right mouse button on the to

edit layer opens the layer settings window. Tool assignment is not possible here.

3.2.2 Tool Assignment Via Layer
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Fig. 3.2-5: Window before switching into the output view

3.2.2.1.1 The Output Button

If the Output button is enabled, the layer settings window switches in the following view:

3.2.2 Tool Assignment Via Layer
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Now, all from the respective driver provided tool modes are listed. When you select a tool,

then the editable parameters and values appear in the list in the upper area of the output

parameter window. Values can now be edited. A doubleclick in the desired field allows

editing of its value. Repeat this operation for each layer and mode which is scheduled for

output.

Fig. 3.2-6: Layer with tool nomination (left-hand) - tool assignment (Middle) - Layer with

assigned tool (right-hand)

Note: When the red hook is visible, a tool assignment had been done. An additional

control is possible via a tool tip in the layer box by placing the mouse cursor on the

layer under investigation and is waiting for some time.

Depending on the output device, different tools and output modes are available. In the

example below, for example, tools of a flatbed cutter are been used. Here it is important to

determine the correct order in which the tools should work.

Fig. 3.2-7: Tool tip control for the "Cut Through Layer"

3.2.2 Tool Assignment Via Layer
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3.2.2.2 How the Tool Sequence Is Determined?

In principle, it should be noted that the processing of the layer is done top down and the

logical sequence of different tools, is applied, so that for example, drawing is active ahead

the cut tool. This sequence can be reordered individually.

Fig. 3.2-8: Layer sequence which should be reordered

The change order function is enabled via the layer order menu item. In the move

layer area you'll find the buttons to change the layer order.

Fig. 3.2-9: Tool sequence reordered - Through Cut above Crease

3.2.2 Tool Assignment Via Layer
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Conclusion:  The tool assignment allows first, the definition of tools, second, the

parameters for each tool, third, the selection of the color (layer) in which the to be

processed objects lie and in the fourth place, the sequence in which the operation should

be processed. GreatCut 4 gives you the flexibility you need in dealing with different output

scenarios and workflows.

3.2.3 The Output

3.2.3.1 Device Setting - Interface Setup (Local Device)

The GreatCut output

With this command you activate the module for cutting, milling, creasing and drawing of

your data.

You activate this function via the  button in the tools toolbar or via the file
menu, menu entry output…

S

Fig. 3.2-10: The output button

When first opening another dialog will be opened before in which the driver of the device

as well as the connection has to be defined.

Fig. 3.2-11: Driver and selection of the connection 

3.2.3 The Output
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General

Under the part of the dialog named General you select the driver of the device.

In the right list all device drivers are listed that are available in GreatCut. In the left list an

individual name for the driver can be distributed. This name will be used in the output

dialogs of GreatCut.

Enable as server

Requirements are at least 2 licenses of GreatCut.

If the option enable as server is activated the output device will be marked as plot server

and can be used by another Plot Manager for the output.

The characteristic features of an output device are that a driver for the processing of the

data has to be distributed to this output device. On the computer on which the Plot

Manager is running the job data for the output are transformed into device data by means

of a driver. The output of the device data can be done in several ways:

Types of connection

Local interfaces

Local interfaces are the interfaces (COM1, COM2, ..., LPT1, LPT2, ...) that are directly on

your computer.

The activation of the settings button opens a dialog for the configuration of the

interface. These settings that are done here apply for the whole system.

Fig. 3.2-12: Dialog for the setting of the interface parameters

3.2.3 The Output
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Indication: When steering serially you have to pay attention that all settings on the

side of the computer as well as on the side of the output device correspond.

Otherwise there is no or faulty communication between them.

USB / Firewire Devices

Here, all momentarily connected USB / Firewire devices are listed.

TCP / IP

Here, you have to enter the TCP / IP address and the port number to which shall be

output.

Spooler

Here, you can select a Windows printer driver.

When opening the output dialog again it will be opened directly with the previously set

device driver.

3.2.3.2 Start of The Output from The GreatCut Working Surface

Fig. 3.2-13: Pre-processing line weight and color gradient

If a GreatCut job contains objects with the attributes contour/line weight or color gradient

the previous dialog appears. Here, the object attributes can be transformed into vectors so

that they are taken into consideration at the output. After clicking on the OK button the

object attributes are transformed into curves.

3.2.3.2.1 Output to device

There are 2 displays of the output to the device dialog: The min.(imized) and the

max.(imized) display that can be activated with the so named button.

3.2.3 The Output
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< Min. display (Standard)

Fig. 3.2-14: Output dialog in < Min display

3.2.3 The Output
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< Max. display

Fig. 3.2-15: Output dialog in > Max display

Output

In the area named output of the output dialog are all selection fields or parameters that

are directly in contact with the output device.

Device

In the field device the previously defined output device is shown.

If the  button is pressed further menu entries are available:

Fig. 3.2-16: Device pop up menu

3.2.3 The Output
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Add local device

With this option further local devices for the output can be defined.

Connect to Plot Manager

With this option devices for the output and that are in the network can be defined.

Change

With this option modifications as for example another interface can be defined.

Delete

With this option a device connection can be canceled or deleted.

Mode / Tool

In the field mode / tool you select if you want to cut, mill, crease, draw with your

device. The functions that are available here depend on the active driver.

Material

In the field material you select the material that shall be cut. This field is linked to a

database that has to be filled which means that the different data for different foils are

entered. For example the settings of print, speed and width on normal foil can be different

to flock or metal foil. These values can be defined individually as they depend on the

material and the device that are used.

Pressing the  button opens the following pop up menu:

Fig. 3.2-17: Pop up menu of the material … button

Add

Activating the add menu item writes a new data record to the material database.

Save material data

If the menu item save material data is selected the previously entered or changed values

are written in the database.

Mode / Tool defaults

If the menu item mode / tool default is selected the values from the database for this tool

are taken over.

3.2.3 The Output
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Material defaults

If the menu item material default is selected the values from the database for this

material are taken over.

3.2.3.2.2 General Settings

The area General settings allows the access to the parameters of the device and

driver. The area is divided in parameter and value. The width of the display can be

changed by moving the vertical line between the areas with the mouse. Whenever value is

written under „edit” a double-click opens the corresponding window for the setup of the

group parameter.

Fig. 3.2-18: Example for an opened parameter group

Number of outputs

The value in the field number of outputs indicates how often the repetition of the

job-output with all set device-parameters shall be carried out.

Number of copies

In the field number of copies you define how often the selected objects shall be cut. After

the cutting this value is automatically set back to 1.

Stack spacing

The value in the field stack spacing defines if the copies shall be stacked vertically and

which space has to be kept between the copies. Pre-condition for the activation of this

option is that the selected object can be cut more than one time on top of each other!

Indication: In the stacking preview the first object is shown „normally“. Each further

object of the stack is shown dashed in blue.

3.2.3 The Output
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Weeding border

With the option weeding border it is defined if and with which space a rectangle is cut

around the plot that facilitates the weeding of the foil. In the output preview the frame - if

activated - is shown dashed in blue.

Copies spacing

The value in the field copies spacing defines the space between the copies that were

entered in the field number of copies.

Segment spacing

The segment spacing defines the horizontal space between the single segments.

Segments always occur if the job has to be sectioned which means divided.

Sort before output

If the option sort before output is activated all objects in the working surface are sorted 1.

in head-direction and 2. in transport direction. If the command sort with simulation…-is

used, its last sort-setting is used.

Stack processing

If the option stack processing is activated all jobs in the queue are processed one after

the other without interruption.

Wait after segment

Sectioning / Segmentation: If a job is too big for the output GreatCut segments the job

automatically in so many parts (segments) that are necessary for the complete output of

the job.

If the option wait after segment is active the output is interrupted after each segment and

the material can be newly adjusted if necessary.

Keep reference point

Via the option keep reference point the zero point (0/0) of the cutter can be moved. If this

option is not active GreatCut selects automatically the physical zero point as starting point

for the cutting.

If the option keep reference point is active the physical zero point is moved about the

offset coordinate of the reference point. The coordinates of the reference point correspond

to the position of the down left corner of the object to be cut on the GreatCut working

surface.

Plot to file

If the option plot to file is active all output data are directed to a file you have to define

and written on the hard drive.

3.2.3 The Output
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Save settings button

By activating the save settings button all values that have previously been entered in the

output dialog are taken over and assigned to the currently active output device.

Feed/origin

Depending on the selected driver the name of the field is either feed or origin.

Friction feed cutter

With origin the options are new origin or don't set. If the option new origin is selected

the device goes into X-direction at a fix set value behind the last cut object and this

position is then the new origin. If don't set is activated the physical zero point is the new

origin after the output.

Flatbed cutter

With feed the options are feed or no feed. If the option feed is activated the material feed

is carried out with the sectioning and with the output from the roll if the flatbed cutter has

an automatic material feed.

Accuracy

The field accuracy offers the following parameters: very low, low, normal, high and very

high. As default, the value normal is pre-defined.

The accuracy defines of how many vector parts an object should consist. This is only

relevant with objects whose size range in the 10th millimeter. Other object sizes are

calculated automatically by GreatCut and the optimum of nodal points for the later output

defined.

Objects

The field objects allows the selection of the objects to be output. Besides the modes all

objects and selected objects GreatCut also allows the cutting of color sequences or of

single color layers. The two last named are explained more in detail in the chapter „color

separation when cutting".

Fig. 3.2-19: List field objects with selection modes.

3.2.3 The Output
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Info Line

In the Info Line information relating to the output process is displayed additionally, e. g.

"Job will be sectioned".

Preview

The preview button opens the output preview.

Output

The output button transfers the data directly to the Plot Manager and to the connected

device.

Read material

The read material button delivers back to all connected devices the height of the area to

be plotted if an accordant command is intended in the firmware for the device. Devices

that do not offer this option no value respective zero is delivered back.

Test drive

If the test drive button is activated the connected devices drives along the Weeding frame

with the tool head lifted. This also happens if the option "weeding frame" was not

activated.

3.2.3.2.3 Color separation when cutting

Each layer color used in the draft appears again in the objects list with the number that

clearly defines each layer color. In addition, in this list field two horizontal color bars

appear. After having transferred the data of a color layer, in the info area of the Windows

status bar the Plot Manager icon ( ) appears.

Double clicking on this icon activates the Plot Manager job control. If the mouse cursor is

positioned on the icon and the right mouse button is pressed, a pop up menu appears in

which the Plot Manager can be closed or the program version can be shown.  In the layer
selection the color layers that have not been processed yet occur in the order in which

they had been selected. The order in the stack can be changed at any time.

3.2.3 The Output
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Fig. 3.2-20: Definition of the order in which the single layers shall be processed by up /

down buttons

The order is defined via the up / down buttons. Layer colors that are not necessary are

deleted from the list with the  button.

Tip: For the color separated cutting use the register marks from the draw tool. Register

marks are cut at the same place on the foil independent from the color used.

3.2.3 The Output
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3.3 Export

If you want to use a job-file also in other programs the data must be made available in

another format than the GreatCut-job-format. This process is called „export”

Indication: Exporting is done with the highest quality and lowest compression.

Fig. 3.3-1: GreatCut Export window with file selection

Save

With the icons next to the Save-field you choose the path in which the export-file shall be

saved.

File name

In this field you enter the name of the export-file.

Type of file

Here, you select in which other format the data on the desktop is to be written.

Following export-filters are available in GreatCut: *.eps (opi), *.cmx (Corel6-X6), *.plt

(HPGL), *: jpg, .pcx, *.tif, *.bmp.

Indication: If objects are selected only those are exported, otherwise all of them.

3.3 Export
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Selected objects

If this option is activated only the marked objects are written in the export-file.

All objects

 If this option is activated all objects are written in the export-file.

Maintain worksheet

With this option the contour of the worksheet is written as object in the export-file.

Bitmap-Export

Fig. 3.3-2: Shade and resolution at Bitmap-export

Shade

The number in front of „Bit per pixel” indicates the exponent of the shade.

Example: 8 bits per pixel = 28 = 256 colors

Resolution

This value defines the amount of pixels per inch. The higher the value the finer becomes

the resolution. The value dpi 300 for example is sufficient for the offset printing.

Indication: Higher values are often not suggestive as the size of the file increases

with higher dpi.

Antialias

The export of a bitmap can also be done with antialiasing short: Antialias, which is a

jaggies smoothing or edge smoothing.

3.3 Export
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3.3.1 PDF Export

3.3.1.1 Additional Options

3.3.1.2 Encrypt Document Option

Enabling the Encrypt Document option allows input of an individual password.

Password

In the input field any password for the document can be filed.

Note: Please make sure that a secure password is used. It should be at least 8
characters long and made of numbers, letters, capital letters and special characters.

3.3.1.3 Set Access Rights Option

Enabling Set Access Rights option allows you to enter an individual password.

Password

In the input field any password for the following access rights of the document can be

filed.

Note: Please make sure that a secure password is used. It should be at least 8
characters long and made of numbers, letters, capital letters and special characters.

PS: The GreatCut PDF export includes a double-stage password protection. The

3.3.1 PDF Export
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first stage refers to the entire document and the second stage to a specific access
rights of the document.

3.3.1.4 Access Rights

Printing not allowed Option

When this option is enabled, printing of the document - without knowing the password -

is not possible.

Content cannot be extracted Option

When this option is enabled, extracting of contents - without knowing the password - is

not possible.

Do not allow "Change Contents" Option

When this option is enabled, editing of contents - without knowing the password - is not

possible.

3.4 Digression: Contour vs Outline vs Contour Line

Often, there is confusion among GreatCut 4 users, because the differences between this

terms are not clear and there can be seen no difference on the GreatCut working sheet, if

the so-called full surface mode is enabled. Not until then the so-called contour mode -

switch on or off using F9 key - differences can be seen. Obviously completely different

functions are meant.

In the following the terms are examined for their similarities and differences.

3.4.1 1. Contour

Definition:

Contour is a property, an attribute of a vector object or a type face, comparable with a

color fill. Color and width can be defined individually.This contour is given out on a laser or

ink jet printer. The tool for the definition of a contour is the pen .

3.3.1 PDF Export
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Fig. 3.4-1: Pen attributes dialog

Fig. 3.4-2: Full surface mode

Fig. 3.4-3: Contour mode

Attention: A contour is not! given out on a cutter, unless the "Convert contours"

function was executed before data  transfer to the output module.

Fig. 3.4-4: Dialog for conversion of contours into cuttable objects

If the option Convert contours is enabled, a vector combination in the thickness of the

contour is generated. This combination is put in a layer with the same color.

Additionally the following dialog appears with a pre-selection of the correct welding method

(here: Weld by Color).

3.4.1 1. Contour
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Fig. 3.4-5: Welding dialog with presetting "by color"

Tip: For testing can be switched into the contour mode in order to control which

objects will be given out.

3.4.2 2. Outline

Definition

Outline is a vector contour around another vector object oder a type face. In differenc to

the term contour the generated contour is a real vector which can be outputted. Another

difference is, that  interior parts are contoured as well with a so-called Inline. Example:

Letters like a, e where the interior parts are also contoured (see fig. below) 

Note: The Outline function is linked with the welding function, so that if contours

are overlapping each other, an error-free output to vinyl gets possible.

Fig. 3.4-6: Outline dialog

3.4.2 2. Outline
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Fig. 3.4-7: Full surface mode

Fig. 3.4-8: Contour mode

3.4.3 3. Contour Line

Definition

By a contour line is often referred in connection with the term: "print & cut". In "Print & Cut"

bitmaps mostly logos - graphics without vectors - are contoured with a vector line, in order

to produce decals, label, sticker on a cutter with OPOS sensor. The contour line is the line

that is cut around each sticker. It is like the pen contour an outline around the entire object.

Note: In this case the thickness of an object cannot be defined; as default a

so-called hairline (0.01 mm) is generated.

Fig. 3.4-9: Contour line dialog

Fig. 3.4-10: Full surface mode

3.4.3 3. Contour Line
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Fig. 3.4-11: Contour mode

Conclusion: The above examples should made clear that it is important to keep apart the

notions. Although, there cannot be seen any difference on the scree when in the full

surface mode, different tools and functions are involved. This example also shows how

flexible the tools of GreatCut 4 are.

3.4.3 3. Contour Line
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3.5 Cutting - Milling - Creasing - Drawing …

3.5.1 The Output Preview 

The output preview is automatically started if you press the preview button in the output

dialog. 

Closing the output preview and returning to the working surface of GreatCut ESC

Fig. 3.5-1: Output preview with toolbars, status line and output objects

In the status line of the cutting preview the following information is shown: contour, filling,

width and height, group or combination, the max. foil consumption in square meters

and running meter (rnm) as well as selected object features. If the output menu is

activated the data are transferred to the output device.

Indication: If the job to be cut is left, underneath or above the material- or table

preview and the output -menu is activated you will automatically be reminded that
the objects to be cut are out of range of the output.

Detailed description:

please refer to 6.7: The Preview Tools Toolbar
please refer to 6.8: The Preview Object Parameters Toolbar

3.5 Cutting - Milling - Creasing - Drawing …
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Foil optimization

The material consumption can be reduced by using the module foil optimization.

Fig. 3.5-2: Parameter dialog for the material optimization

The foil optimization takes care that all objects are arranged in a way that they take the

least space on the material.

Indication: Groups and combinations are each regarded as an optimization object. If

this is not desired the grouping must be interrupted and the combination cancelled.

Following options are available:

Weed border distance

In this field the desired distance between the optimization objects, the so called weed

border distance can be set.

Rotate objects to shorter side

All objects are rotated so that the shorter side is downwards.

Rotate as needed

During the optimization all objects are rotated so that they can be arranged saving the

most space.

Include bitmaps

If this option is activated, bitmaps and groups that contain bitmaps are also optimized.

3.5.1 The Output Preview 

55



Only selected objects

Only the selected objects are considered. With this option you can for example optimize

according to layers (colors).

Maximum optimization

If this option is activated two more fields are shown in the foil optimization dialog. The

option maximum optimization calculates all possible combinations the can arise from the

fields end optimization up to maximum ... objects and permutation depth. The

calculation can take much time depending on the size of the here set values as all

possible combinations that arise from the two values are calculated and compared.

Therefore, you should usually not set more than 20-30 objects with a permutation depth of

max. 5.

Indication: An optimization always leads to the rotation of one or several objects.

3.5.1.1 Weeding lines

Weeding lines serve for the better procession of large jobs. Material length or width of

several meters are difficult to handle, therefore, you can insert weeding lines during the foil

cutting that divide the job into smaller parts that are more easy to handle.

Fig. 3.5-3: Output job with weeding frame (dashed in blue) without weeding lines

3.5.1 The Output Preview 

56



Fig. 3.5-4: Example with 3 horizontal and 3 vertical weeding lines (dashed in red)

Fig. 3.5-5: Result of the output with weeding lines - objects not! cut

In the output preview there are 3 possibilities to insert horizontal and vertical weeding

lines.

Indication: Weeding lines can only be inserted if the option weeding frame has been
activated in the output dialog.

1. Manually

Position the mouse cursor on the weeding frame dashed in blue around the objects. The

mouse cursor changes into a double-headed arrow. Now draw a horizontal or vertical

3.5.1 The Output Preview 
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weeding line to the position where it should be segmented. Repeat the process until all

necessary weeding lines are inserted.

2. Via the menu options

Open the menu options and activate the menu item horizontal weeding line or vertical

weeding line.

The first weeding line is inserted in the middle of the objects to be cut. The second call up

of the function bisects the two halves in two more halves and so on.

3. Via the shortcuts h or v

An „h” or „v” directly entered via the keyboard generates the respective weeding lines - as

described in 2.

Tip: Single objects can be provided additionally with a separate weeding frame via

the right mouse menu.

3.5.1.2 Job Sectioning

Sectioning is the division of a job in so many parts (sections) that are necessary for the

complete output of the job.

If the job to be output is bigger than the set or the available output width (output dialog,

field width of material) of the output device in the information area of the output dialog

the indication „job will be sectioned“ is shown.

Indication: The terms sectioning and segmentation are used as synonyms.

The activation of the output menu then opens the following dialog before the transfer to

the device:

Fig. 3.5-6: Sectioning dialog with overlapping of 3 mm

3.5.1 The Output Preview 
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Optimize material (max. size + smallest at last)

Optimize … smallest at last) causes GreatCut to create segments in the maximum

permitted size. The size of the last segment usually differs from the others

Optimize material (max. size + smallest at first)

Only active with flatbed cutters. If the last segment was also cut as last the plate could not

be processed until the end. Therefore, the remainder is cut as first so that the plate lies on

the table until the end.

Segment optimization (segments of equal size)

If the option segment optimization is activated always segments of the same size are

created.

Optimize segments by mark posiions

This option is activated as default with GreatCut if video markers exist in the Job. The

above dialog is skipped and the preview of the dynamic segments is shown. The reason of

this optimization is that always at least 3 video markers are necessary. Depending on the

location of the video markers GreatCut "searches" up to 30% next to the segment line if

there is a video marker. If yes, the respective segment is adjusted dynamically.  

Preset segmentation

The last used setting is automatically saved. When loading the job again this sectioning

can be accessed.

Reverse cutting

The option reverse cutting indicates that the objects are cut as „negative“ for example for

the use as template for the screen printing.

X-overlap and Y-overlap

Segmentation with overlapping - In the fields X- and Y-Overlap you can define how much

the segments shall overlap. The vectors are enlarged accordingly at the cutting points.

3.5.1 The Output Preview 
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Fig. 3.5-7: Foil optimization in the sectioning preview with 8 segments and information on

segment sizes

Selection and deselection of the segments

Selection and deselection of the segments is done by clicking into the segment. The red

checkmark indicates which segment is active and being output. 

Changing the suggested sectioning

You can change the sectioning by clicking on the blue section lines and move them to the

desired position with the mouse. If necessary GreatCut inserts automatically new sections.

In the status line of the segmentation preview the size of the job to be cut in X- and

Y-direction and the number of segments are shown.

3.5.1 The Output Preview 
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3.6 Printing

Fig. 3.6-1: The print button in the standard toolbar

3.6.1 Without RIP Software

The following chapters explain in detail the single functions of the GreatCut print dialog.

Open the GreatCut print… dialog by selecting the menu item print in the file menu, via

the keyboard hotkey CTRL+P or by pressing the  button in the toolbox.

Fig. 3.6-2: The print dialog

In the down right part of the dialog you find the option tile and the adapt button and the

1:1 button under output. Depending on which option you have activated the appearance of

the preview of the print -dialog changes.

Indication: If the print -dialog is opened the adapt button is automatically active

because we do not assume formats that exceed the maximum output-size of the
device to be accessed as standard for the printing of objects or graphics.

3.6 Printing
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The adapt mode

The adapt-mode corresponds to the printable area. The values for the printable area are

shown in the field print area which is in the upper right part of the print dialog.

The preview window in the adapt mode

The preview window offers the possibility to check your job before printing. The edges of

the window are magnetic which means that if an object is approaching the edge of the

sheet the object stays at the edge of the window.  Thus, a faster positioning of the objects

in the corners or at the edges of the sheets is obtained.

Tip: If the magnetization of the edges shall be switched off, keep the SHIFT button

pressed while positioning your objects.

The x- and y-coordinates that are shown underneath the preview window express the

location of the left upper edge of the object on the working surface.

Mouse-functions in the preview window (adapt-mode)

Clicking once with the right mouse button or activating the preview button increases the

preview window to the maximum size of display.

Fig. 3.6-3: The print preview button

Fig. 3.6-4: Print preview in the complete picture mode

3.6.1 Without RIP Software
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Indication: The size of display depends on the set screen resolution (800*600,

1024*768, ...). Clicking again with the right mouse button resets the original status.

Indication: If the left mouse button is pressed and kept pressed, a dashed black

frame appears around the objects to be printed. This frame covers all objects that

are on the working surface and corresponds to the printing area.

Printable area and object

The fields Printable area and object are in the upper right part of the print dialog.

Fig. 3.6-5: Section field printing area and object

Printable area

In this field, the specified printing area with height and width values is shown.

Object

In this field the object/s to be printed with height and width values is/are are shown.

Indication: The fields for the percental enlargement of the objects are not active in

the adapt-mode.

One field below on the right side of the print dialog is the field printer.

Fig. 3.6-6: Printer selection and Setup

If you open the list you will get a list of all printers that are installed on your system. Select

the printer that you want to use. In order to do more settings for the printing activate the

setup button. The dialog that now opens corresponds to the menu item properties of the

respective printer file menu.

Indication: The print dialog that is opened by pressing the setup button depends on
the loaded printer driver and is therefore not further explained.

Right next to the setup-button the orientation of the sheet (portrait / landscape) can be set.

What is printed?

In the area named print mode are two combo-boxes in which you can define what shall be

printed. In the first list you can choose between the options objects, objects with
worksheet, job-info and job-calculation.

3.6.1 Without RIP Software
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Objects

All objects on the worksheet are printed.

Objects with worksheet

All objects and the worksheet (black frame) are printed. Underneath the black frame the

company´s name, the dimensions of the working surface and the proportion in which it

shell be output are also automatically printed.  

Job-info

If this option is activated all information that have been entered in the job-info are output

as well as all objects in the below right area of the sheet are printed downsized.

Job-calculation

If this option is activated the information that have been entered in the job-calculation are

output.

The following setting- possibilities are available in the second list: all objects, selected

objects, color separated printing (printing in the order of the layer), printing of single

layer (colors).

All objects

All objects that are on the working surface are printed.

Selected objects

Only objects are printed that have been marked on the working surface.

Color separated printing

All objects of one color are printed in the order previously set. The color bar (layer-order)

in the second list contains all colors (layers) that have been used on the working surface

and corresponds to the later printing order.

Indication: The printing is always started with the darkest color.

Printing of single colors (layer)

All colors listed in the second list correspond to those that have been used for the objects

on the working surface. If there is for example only one black and one red object only two

color bars (layers) are offered as selection.

Ratio

Here, you have the possibility to enter the printing proportion as numeric or percentage

values.

3.6.1 Without RIP Software
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Indication: Both fields are coequal which means that if a numeric value is entered
the corresponding percentage value is entered automatically in the dedicated field

and vice versa.

Fig. 3.6-7: Field for the entry of the size proportion

Examples for the indications of proportion with the corresponding percentages:

Proportion 1 : 1 corresponds to 100.00 %

Proportion 1 : 2 corresponds to 50.00 %

Proportion 1 : 3 corresponds to 33.33 %

Proportion 1 : 4 corresponds to 25.00 %

Centered

If this option is activated all objects on the working surface are centered.

Tiling

If this option is chosen the print -dialog appears in the tile mode.

Number of copies

In this field the number (max. 9999) of the exemplars to be printed can be defined. The

buttons adapt and tile enable switching between the two modi with the same name.

1:1

If this button is activated all objects on the working surface are displayed in their original

size in the preview window and output.

Adapt

If this button is activated all objects on the working surface are downsized so that they can

be shown completely in the preview window.

Options

Output to file - Print to file

If this option activated, print data is redirected to a file.

3.6.1 Without RIP Software

65



Contour mode

With this option activated all objects are printed like shown in contour mode - without

filling.

Also print colored worksheet

When selecting this option the background color defined for the working surface is also

printed.

Print subsidiary lines

If the job to be printed contains subsidiary lines they are also printed.

Always print black

This option becomes automatically active if in the first list all objects and in the second list

color separated printing (after the layer order) or print single colors (after single layers)

was selected.

Indication: If you want to print the objects on the working surface in color the option

always print black must be deactivated.

Register-/ Jog-Marks

This option becomes automatically active if in the first list all objects and in the second list

color separated printing (after layer order) or print single colors (after single layers)

was selected.

Indication: If you do not want to also print register and jog marks this option must

be deactivated.

3.6.1.1 The Tile Mode

If you switch from the adapt mode to the tile mode the preview window appears as

follows:

3.6.1 Without RIP Software
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Fig. 3.6-8: The preview window in tile-mode

In the tile mode all tiles are shown. A tile is that part of the object that can be output on the

device to be accessed.

The option pause after indicates after which tile (enter amount of tile) the output shall be

interrupted. The fields overlapping (mm) serve for the entry of the desired horizontal and

vertical overlapping of the objects to be printed.

When printing to roll (option Roll), whole lanes can be printed without having spaces

between the single tiles.

Indication: Only the print of a whole lane can be interrupted and not the printing of a
single tile. The entry of an overlapping in feed direction (print direction) has no

influence on the roll which can also be seen at the display of the size of the tile.

After the tiling the dialog is not closed automatically as it is an advantage to directly

compare the print and the preview. In addition, thus you can directly repeat the print of a

specific tile.

Mouse function in the preview window (tile mode)

One click with the right mouse button on the tile preview increases the tile display. This

can also be done by clicking on the -button in the upper left area of the window. Clicking
once again with the right mouse button resets the original status.

3.6.1 Without RIP Software
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If you double click with the left mouse button on a tile this one will be deactivated which

means it will not be printed.

Double clicking with the left mouse button while pressing the SHIFT button leads to the

inversion of the tiles which means that the tiles that have been deactivated before become

now active (printed) and the tiles that have been active become deactivated (not printed).

The objects within the preview window can be shifted by means of the mouse. The window

edges are magnetic which means that when the object is approaching the edge of the

sheet the object remains clinged. When pressing the SHIFT button the magnetization is

released.

Example for the printing in the tile mode

The following example explains the single functions, shortcuts,... in the tile mode in detail.

The tile mode offers the possibility to print in any size which means each graphic,

independent of the size can be printed on the connected output device. For the print of

your graphic you do not need a printer with which DIN A2-, A1-, A0- or even large size can

be output. 

How?

The graphic to be printed is divided in so many segments (tiles) that are necessary to be

able to output the graphic on the connected output device. The amount of necessary tiles

depends on the size of the graphic to be output and the pre-defined output format (DIN A3,

A2, ...). The setting of the output format is done via the set button GreatCut print dialog

and depends on the connected output device.

Load any graphic in GreatCut and open the print dialog, either via the file menu by

selecting the menu item print..., via the keyboard with the key combination CTRL+P or via

the button in the standard toolbar.

The GreatCut print dialog is opened in the adapt mode. Activate the tile mode by

activating the thus named button.

The print dialog appears as follows:

3.6.1 Without RIP Software
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Fig. 3.6-9: The print dialog in the tile mode

In the upper right corner of the dialog you find the two fields tile and object.

The field tile corresponds to the field print area in the adapt mode. The other fields in the

right part of the print dialog are the same as in the adapt mode.

Fig. 3.6-10: Preview with settings in the tile mode

Activated and deactivated tiles

An active tile is a tile that is not marked with a red „X”. Deactivated tiles on the other hand

are marked with a red „X”.

3.6.1 Without RIP Software
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Fig. 3.6-11: Bottom row: Tiles deactivated

The deactivation or activation of a tile is done by double clicking with the left mouse

button which means when double clicking on an active tile it becomes deactivated.

Another double click on the same tile activates it again.

In the previous figure you can see that the lower row of tiles is marked with a red „X”.

These tiles were deactivated and will not be printed.

In the tile mode you do not only have the possibility to activate / deactivate single tiles.

Tip: Keep the CTRL button pressed while double clicking with the left mouse button

on the desired tile and all tiles where the mouse cursor is are deactivated.

3.6.2 With Pjannto RIP software

Fig. 3.6-12: The Pjannto RIP button in the standard toolbar

Indication: Pjannto RIP is a professional PostScript-RIP that is not a part of
GreatCut. If a license was purchased from Pjannto RIP and the software is installed

on the same computer the Pjannto RIP button is automatically embedded in the
standard toolbar of GreatCut and the file menu enlarged with the entry Pjannto

RIP… .

3.6.2 With Pjannto RIP software
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4 Reference Part

The menu items in chronological order:

4.1 The File Menu

4.1.1 The New… Command

With the New command a new job is opened. CTRL+N

4.1.2 The Open… Command

With this command the files that were stored on your hard drive or another

data carrier in the GreatCut JOB file format are brought onto the current

screen / desktop. You can further edit this file. Jobs can be deleted after a

safety query.

 CTRL+L

4.1.3 The Save Command 

With this command you save the current job. If the respective job has

already been stored before, the given file name and the directory are kept.

The older version of the job is overwritten so that the old version can not be

restored any more.

If you have created a new job that has not been saved before, the program,

if you have clicked the save command in the file menu, goes automatically

to the command save as… .

First, the job info dialog is opened where you can enter more information

about the job. Then, the real dialog for saving your job is opened and you

are asked to enter the file name and select the directory.

CTRL+S

4.1.4 The Save as… Command

With this command you save a new job under a file name chosen by you in

a directory to be selected. This command is also for changing the file name

and / or directory of already existing files. If for example you want to save a

job that is build up on an older one without losing the old version then you

select the command save as ... and you can save the new job under

another name in a new directory if you wish to.

The command save as... is also to be selected if you want to save the

current job onto another data carrier. To do so, select the appropriate disk

drive.

SHIFT+
CTRL+S
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4.1.5 The Send by Email… Command

This command opens the standard email client and links the current job as

attachment to the email. The job must be saved before.

4.1.6 The Import… Command

With this command files are imported into GreatCut. Known file formats are

shown in a list.
CTRL+I

4.1.7 The Export… Command

If you want to use a job also in another program the job file must be

converted into a suitable format which means exported.
CTRL+E

4.1.8 The Send to RIP… Command

With this command the PostScript RIP is started, if it was installed and

activated (licensed) before.

Note: This menu entry is only visible, if an EUROSYSTEMS RIP had

been installed and activated (licensed) before. Then the RIP-Setup in

GreatCut 4 must be processed: please refer to 4.6.1.6: The RIP…

Setup

4.1.9 The Print… Command

With this command you print the current file in any size (tiles) on the

standard printer.
CTRL+P

4.1.10 The Output… Command

With this command you call the output module (Plot Manager) for cutting,

drawing or milling.
S

4.1.11 The Quit Command

With this you terminate GreatCut and return to the Windows desktop. If you

have not saved the job that is currently being edited, you will be asked if you

want to do so.

CTRL+Q

4.1.12 The Job History

The Job History function facilitates the loading of the 4 last jobs without

having to pass via the directory tree. At the end of the menu list of the file
menu the names of the 4 last edited jobs appear. Click with the mouse

button on the desired job name. Then, the selected file will be loaded on the

4.1.5 The Send by Email… Command
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working surface.

4.1.12 The Job History
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4.2 The Edit Menu

4.2.1 The Undo Command

With this command it is possible to undo the last done operations and

functions. The default setting is 5 steps. This default value can be changed

via the settings menu, menu entry standard settings / miscellaneous and

here undo levels. The maximum value is 100 steps.

Indication: This setting can only be changed with a new file (file menu,

menu item new)!

F5

4.2.2 The Undo Stack… Command

This command opens a window with the last used commands. Most

intermediate states are previewed. By clicking on the respective command

this state is restored.

Note: This menu entry is only displayed, if restorable commands are

used.

SHIFT+F5

4.2.3 The Redo Command

This command is the reverse command to undo. It restores the status that

was there before the undoing.
F6

4.2.4 The Redo Stack… Command

This command opens a window with the last commands, which were made

undone. Most intermediate states are previewed. By clicking on the

respective command this state is restored.

Note: This menu entry is only displayed, when commands were

undone.

SHIFT+F6

4.2.5 The Cut Command

With this command objects are copied to the Windows clipboard and deleted

from the working surface. Via the clipboard objects can be inserted at

another place or in another program.

Indication: For the transport of your data you can also use the export

command. This is always necessary if your data shall be transferred to

another computer.

CTRL+X

4.2 The Edit Menu
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4.2.6 The Copy Command

With this command marked objects are copied to the clipboard without

deleting them from the working surface.
CTRL+C

4.2.7 The Paste Command

This command inserts graphics and objects from the clipboard to your job.

The mouse cursor changes to a right angle in which insert is written.

Now point the tip of the right angle to the point on your working surface

where the graphic or the object shall be inserted.

CTRL+V

4.2.8 The Paste Special... Command

Via this menu item "pictures" can be imported from the clipboard to

GreatCut.

Indication: If in GreatCut objects are copied this menu item is not

active.

4.2.9 The Select All Command

With this command all objects of the active job which means all objects on

the working surface and also outside the working surface are marked. The

selected objects can then be grouped, combined or moved.

CTRL+A

4.2.10 The Reverse Selection  Command

With this command all non-selected objects are selected. Already selected

objects will be unselected.
SHIFT+E

4.2.11 The Color Layer… Command

This command starts the layer settings dialog in which objects are colored,

foil colors are defined, device tools are assigned, objects of the same color

are selected and layers can be made invisible or blocked.

L

4.2.12 The Multi Copy… Command

This command serves the generation of any number of object copies (duplicates) on the

working sheet. Number, Offset and more can be set in a dialog.

Detailed description: please refer to 6.4: The Object Parameter Toolbar

4.2.6 The Copy Command
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4.3 The Design Menu

4.3.1 The Rotate Axis Command

This command rotates the marked objects at 90° counter-clockwise.

This option is always necessary if you want to adjust your objects fast to the

rolling direction of the foil without having to go via the rotate function.

A

4.3.2 The Rotate Axis With Page Command

This command rotates the marked objects with page at 90°

counter-clockwise.
SHIFT+A

4.3.3 The Horizontal Mirror Command

The selected object is mirrored at its horizontal through its center point. If

several objects are marked, the center point of the virtual checkbox whose

edge is limited by the 8 black dots with the corresponding horizontal is taken

as axis of reflection. If no objects are marked all objects are mirrored.

X

4.3.4 The Vertical Mirror Command

The selected object is mirrored at the vertical through its center point. If

several objects are selected the center point of the checkbox with its

corresponding vertical is used as axis of reflection. If no objects are marked

all objects are mirrored.

Y

4.3.5 The Delete Command

Pressing the DEL key executes the delete command. In order to delete

particular objects from your graphic they must be marked.
Del

4.3.6 The Mirror on the X Axis Command

 All selected objects will be mirrored at the visible X-coordinate axis. SHIFT+
X

4.3.7 The Mirror on the Y Axis Command

 All selected objects will be mirrored at the visible Y-coordinate axis. SHIFT+Y

4.3.8 The Duplicate Command

In order to use this command the object to be duplicated must be marked

before. Now click with your left mouse button on the duplicate command or

activate it via the hotkey. The marked objects are now doubled.

CTRL+D

4.3 The Design Menu
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The positioning is done according to the values that you have entered in the

settings menu, menu item standard settings / miscellaneous.

Indication: You can also duplicate an object by first marking it, moving

it with the left mouse button kept pressed and then press the right

mouse button once at the position where the duplicate shall be

created. The displacing values are entered automatically with this

procedure.

4.3.9 The Clone Command

If you clone an object you create a copy linked to the object. Modifications at

the original (the initial object) are automatically done at the clone (the copy). 

If a clone is modified in its size or form, an other "original" is created.

4.3.10 The Group Command

This command allows combining several objects to a group in order to edit

them together. This can be wise if for example you want to move several

objects without changing their position to each other. To do this, first mark

all objects that you want to move together, select the group command and

then move the newly created group to the desired place. Now, it is not

possible any more to change the single objects that form the group

independently from each other. 

In order to make this possible again the grouping must be broken with the

break group command.

Indication: Grouped objects cannot be treated with the node editing
tool. The grouping must be broken before. In order to differentiate

between the grouped and ungrouped objects they are shown dashed
in blue.

CTRL+G

4.3.11 The Break Group Command

This command is used to divide a group of objects again into single object.

Each object can then be edited individually.
CTRL+B

4.3.12 The Combine Command

This command combines like the grouping several objects to one. The

difference to the group command is that the selected objects are not

regarded as single isolated objects lying next to another anymore.

Let us explain this fact with an example.

You have created two squares with different sizes, the smaller one lying

completely within the bigger one. In order to obtain that in the

SHIFT+K

4.3.8 The Duplicate Command
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full-color-mode the area of the smaller square is transparent you combine

the two squares after having marked them before. The size of the bigger

square is now interpreted as outer edge and the smaller one as inner edge.

The area between the two edges is filled with the color selected in the layer

box. In the middle, a hole with the size of the smaller square remains.

4.3.13 The Break Combination Command

With this command you cancel a combination. Now, the program treats the

combination objects as single objects again.
SHIFT+L

4.3.14 The Draw Command

In this menu the tools with which you can create graphic objects are

summarized. All tools can be activated via the toolbox or the menu item

draw in the object menu.

4.3.14.1 Register Mark

With this option you can place register marks as administer help in your

graphic. This function enables the accurate mounting of the color separated

cutting job. To do so, activate this command and click the register marks to

the desired positions. Register marks are cut along layer neutral (color

neutral).

If open objects where drawn, they can be closed via right mouse button with

menu item Close.

4.3.15 The Align… Command

With this function marked objects are aligned. You can align the objects

horizontally or vertically. The objects are arranged in that way that they are

either centered or aligned at the desired side.

In addition, the objects can be aligned with the same distance so that a

steady appearance is obtained.  It is also possible to center all objects

horizontally or vertically on the working surface.

Indication: This option can only be activated if you have marked at

least 2 objects.

R

4.3.16 The Sort With Simulation… Command

This command opens the object sort function with which the output order

and direction of rotation of the objects can be defined. The sort can be

done dependent or independent of layers. Also, the preferential direction

of the sort can be defined.

In a preview the output of the object is simulated graphically; here, the

traverse path of the tool head can be sketched. The simulation can be

CTRL+F10
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repeated unlimited without changing the original objects.

4.3.17 The Sort Manually… Command

This command enables a manual object sortation. For every single output

object the order and direction of rotation can be defined. This can be done

for every layer. In the preview window the objects are clicked to the

desired order with the mouse cursor. Alternatively, the objects can also be

sorted by clicking in the object list. The sorted objects are shown dashed

in blue. 

CTRL+F11

4.3.18 The Clockwise Command

This command sets the direction of rotation of the marked objects to

clockwise.

Indication: This function is only relevant in connection with a

connected milling or engraving device.

>

4.3.19 The Counterclockwise Command

This command sets the direction of rotation of the marked objects to

counter-clockwise.

Indication: This command is like the previous only relevant in

combination with milling applications.

<

4.3.20 The Close Contour Command

With this command open objects can be closed. You can see in the status

line if an object represents an open track or not. To close it you mark the

object and use that command.

SHIFT+S

4.3.21 The Open Contour Command

With this command closed objects can be opened.

Indication: The menu item open contour corresponds to the separate

function in the node tool.

SHIFT+O

4.3.22 The Round Corners… Command

The round corners command rounds down nodal points with a freely

defined radius. 

The rounding can be done inwards or outwards. The rounding can also

affect the whole object or just single nodes.

SHIFT+
CTRL+R
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Indication: This function can also be used for the rounding of font
characters.

4.3.23 The Weeding Border Command

This command generates a so-called weeding border or frame around one

or more selected objects. A weeding border facilitates weeding of the vinyl

from the carrier.

4.3.22 The Round Corners… Command
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4.4 The View Menu

4.4.1 The Zoom In Command

If you select this function the mouse cursor changes into a lens with a plus

inside. You can now select an area that shall be zoomed by keeping

pressed the left mouse button. The selected area will then be shown

increased to the maximum in the program window.

Indication: A beep of the computer loudspeaker informs you that the

maximum zoom is reached.

+(NUM)

or  F2

4.4.2 The Zoom Out Command 

This function decreases the working surface gradually. If it had been

zoomed repeatedly before, the single zoom steps are carried out backwards.
-(NUM)

or  F3

4.4.3 The Full Page Command

Select the function so that the whole available working surface is shown. B

4.4.4 The Show All Command

This function changes the display of the vector drawing in this way that all

objects can be seen in the program window. The section is chosen in that

way that it is the biggest possible display of the graphic showing all objects.

Indication: If you keep pressed the SHIFT key while doing this
command only the marked objects are zoomed to maximum.

F4

4.4.5 The Show Selected Objects Command

If this command is activated only the objects marked on the working

surface are displayed as big as possible.
SHIFT+F4

4.4.6 The To Front Command

If you have arranged several objects on top of each other the following

commands enable you to modify the location of the objects to each other.

With the to front command the marked object is set on the top place above

the others.

CTRL+O
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4.4.7 The To Back Command

With this command you set the marked object underneath respective behind

all other objects.
CTRL+U

4.4.8 The Forward One Command

This command sets the marked objects further front in the display. PgUp

4.4.9 The Back One Command

With this command you set the marked object further down and thus further

back in the display.
PgDn

4.4.10 The Reverse Order Command

The order of the objects in the stack is reversed. What was lying on top then

lies at the bottom and vice versa. This also applies for all objects

in-between.

U

4.4.11 The Change Order Command

With this command you can change the order of the objects in the display

interactively by clicking the objects one after the other in the desired order.
SHIFT+R

4.4.12 The Contour View Command

This command switches the display of the working surface to the contour

mode which means that only the contours of the objects are shown.
F9

4.4.13 The Enhanced View Command

With this command you can obtain the best possible display of the objects

(smoothened contours).

Indication: It slows down the speed of processing and should

therefore only be used for the last check or presentation.

SHIFT+F9

4.4.14 The Always on top Command

The GreatCut window remains always in the foreground.

Indication: This menu item is only active if the GreatCut window is in

the window mode.

CTRL+Y
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4.4.15 The Refresh Screen Command

With this function the content of the visible window is build up again without

changing the size or the selected section.

Indication: Use this command if objects on the screen are visible that

cannot be accessed by the arrow tool or if display errors of another

kind occur.

CTRL+W

4.4.15 The Refresh Screen Command
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4.5 The Tools Menu

4.5.1 The Contour Line… Function

With the contour line function the outer edge of arbitrary many objects is

calculated and provided with a contour. Contrary to the outline with this tool

also bitmaps can be contoured. In addition, not every single object is

contoured but it is tried to find only one contour that comprises all selected

objects. Therefore, this function is especially suitable for the creation of

intersection lines around labels. The objects of the label can be arranged

arbitrarily. Afterwards, with the tool described here the contour of the label in

the desired distance is calculated. The thus created contour can be used

later for cutting the printed label.

Detailed: please refer to 3.4: Digression: Contour vs Outline vs
Contour Line

K

4.5.2 The PhotoCut… Function

The function creates vectors from bitmaps. PhotoCut calculates from

Windows Bitmap files (*.BMP, *.PCX, *.TIF) grids or patterns that can be

output with a cutting plotter or a similar device. The picture is divided into

logical pixels and the average gray value calculated for each of these logical

pixels. So, a picture is created that has less pixels than the original. Out of

this picture horizontal or vertical stripes, circles, squares, ... are created

whose width is proportional to the gray value at the respective position.

please refer to 7.10: The PhotoCUT Function

4.5.3 The Set Jog Marks Command

This command automatically sets jog marks around the selected objects.

Type, size and position relative to the selected objects are pre-set in

settings / standard settings / register / jog marks menu.

Indication: The markers do not lie in a layer, are always displayed in
black, keep their scaling and size and are grouped when being created.

SHIFT+J

please refer to 4.6.1.4: The Register / Jog Marks… Setup

4.5.4 The Search / Replace Video Marks Command

With this command circle objects in an import file - with an in the

Register-/Jog Marks menu entry defined size - are searched and replaced

by video marks.

4.5 The Tools Menu
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Note: This option can also be set as a standard via the Settings /
Standard Settings / Filter menu entry.

4.5.5 The Measure Command

With the function measure an arbitrary track can be measured, scaled,

rotated and dimensioned. If you have activated this command the mouse

cursor changes into a reticle. It is then set at the starting point of the track to

be measured and the mouse button pressed and kept pressed. Then, the

mouse cursor is moved to the end of the track to be measured and the left

mouse button let go. With the SHIFT key pressed you only measure

horizontal and vertical distances. Now, the result of the measurement is

shown in a dialog field and can be modified.

Indication: The modification of the size is applied proportionally to all

selected objects. When rotating bitmaps the area of the bitmap

increases but not the objects displayed in the bitmap.

M

4.5.6 The Optimize Material… Function

The optimization takes care that all objects are arranged in a way that they

take the least space on the output. By rotation or no rotation of objects it is

taken care of that the waste of material can be reduced.

4.5.7 The Outline… Function

This function creates a contour with a distance around a vector object to be

freely selected and is mostly used for contouring text objects. The color of

the target layer can be pre-selected. Inline, the reverse function creates a

contour lying inwards. „Outline & Inline” combined creates a closed

contour in the pre-selected strength. 

Indication: Contrary to the contour with combined objects
simultaneously an inner contour is created. This function is not to be

confused with a contour pen that only is a drawing attribute and no
vector object.

O

4.5.8 The Welding Command

The merge functions manually, automatically, trimming, open trimming,
fill, by color, full area and screen printing take care that overlaying object

parts what would cut the foil are eliminated and connected.

W

please refer to 7.6: The Welding Tool

4.5.4 The Search / Replace Video Marks Command
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4.6 The Settings Menu

4.6.1 The Standard Settings Menu

4.6.1.1 The Miscellaneous… Setup

The following defaults can be set:

4.6.1.1.0.1 Duplicate Objects

X offset

Indicates the value that remains between the original and the duplicate (in

X-orientation) after the creation of a duplicate.

Y offset

Indicates the value that remains between the original and the duplicate (in

Y-orientation) after the creation of a duplicate.

With dyn(amic) adaptation

This option takes care of the switching on or off of a function that

automatically enters and uses the duplication values as X- or Y- orientation

when duplicating with the right mouse button.

4.6.1.1.0.2 Dimensioning

Font height

In the Font height field the default font height of the dimensioning text can

be pre-set.

Alignment to object

With this option the placement of the dimensioning line plus text can be

defined: left, top or bottom or right, top or bottom.

4.6.1.1.0.3 Move Objects

X increment

Indicates the value how much the marked objects are moved or displaced

when pressing the arrow keys on the keyboard.

Y increment

Indicates the value in Y-orientation how much the marked objects are moved

or displaced when pressing the arrow keys on the keyboard.

CTRL+J
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Indication: If you keep pressed the SHIFT key during the movement,
the value of the displacement is reduced to a tenth part. If you keep

pressed the SHIFT + CTRL key the displacement is a hundredth of the

set step size.

4.6.1.1.0.4 Job

Autosave interval

The autosave interval indicates the duration when your job data are

automatically saved on the hard drive. This backup file is always in the

GreatCut main directory. Its name is always autosave.job.

Max. number of jobs in history

The value indicates how many last opened jobs are listed at the end of the

file menu.

Don't ask for save on exit

This option suppresses the save prompt, when the program is closed.

Prompt „overwrite file?” when saving

This option takes care that it is checked before saving if the current file shall

be overwritten.

Ask for „convert contour pen / color graduation?” before output

This option switches on or off the query that checks before the transfer to

the Plot Manager if the line weight and/or color gradient shall be changed.

Display job icons in Windows Explorer

This option generates a minimized job content  thumabnail in front of the file

name. This facilitates the file search.

Max. undo levels

Refers to the undo function in the edit menu.

Indication: This option can only be set if no job is loaded.

No undo / redo for bitmaps larger than ... MB

For bitmaps that are bigger than the value set in this field the

undo/redo-function is automatically switched off which means that the

operations on this bitmap cannot be made undone.

Advantage: saving of time.

4.6.1 The Standard Settings Menu
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Reason: The expenditure of time (computational expenditure) for bitmaps

from a specific size onwards becomes too big as for every undo / redo step

a copy of the original (initial state) must be created.

The value that is entered in this field should be between 5-10% of the RAM

available in the computer.

Delete undos before printing (max. memory utilization)

The delete undos before printing option deletes all undos done so far.

4.6.1.2 The Mouse… Setup

CTRL+right mouse button assigned with

Here, you can define the assignment of the right mouse button. To do this,

open the selection list and select the command that shall be carried out

when clicking once with the right mouse button.

Delay at mouse click

This option increases the marksmanship when selecting objects. The default

value is 100; the unit is millisecond. The higher this selected value the

longer it takes until the object follows the mouse cursor.  An accidental

displacement of the objects is thus decreased.

Note: Users that are not so sure with the handling of the mouse should

increase this value.

Mouse Wheel

These options ease the navigation on the GreatCut desktop with computer

mice, which a equipped with a mid-wheel button.

Zoom

This option - starting from the cursor position - increases or decreases the

working area when turning the mouse wheel: according to the direction of

rotation.

Scroll vert.(ical)

This option - starting from the cursor position - moves the working area

horizontally (Wheel + CTRL key) or vertically when turning the mouse wheel.

According to the direction of rotation the movement is done to the left, top or

bottom or to the right, top or bottom.

Note: The SHIFT key toggles between Zoom and Scroll mode!

Scroll window automatically

4.6.1 The Standard Settings Menu
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This option is switched on by default and takes care that whenever an object

is moved above the edge of the working surface with the mouse, the working

surface automatically is moved, scrolled.

4.6.1.3 The Output Devices… Setup

This category of the basic settings allows the definition of important

parameters for the output on the output device. The default settings

correlate with the information in the output dialog before the output of the job

data to the connected device.

Current output device

Here, the momentarily connected output devices are listed, the driver name

and the connection -interface as well as the mode and the material from the

material database are shown.

The … button enables the new creation, modification and deletion of the

respective pre-setting.

Port

Indicates with which computer interface the output device is connected.

Default Settings

Keep reference point

This option takes care that no new origin is set after the output of a job. The

successional output is done at the same coordinates as the previous.

Stack processing

This option enables an uninterruptible output without an interaction of the

Plot Manager.

Wait after segment

Waiting after segment indicates if the cutter shall remain at this position after

the output of a cut segment. This option is typically needed with flatbed

devices without integrated automatic foil transportation.

Segment thus indicates the maximum addressable area that can be

processed in one piece.

After the segment the foil is forwarded by hand to the correct position.

Sort before output

Sort means that all inner objects are processed before the outer objects and

that a sortation is done in x-axis-orientation. This switch takes care that the

4.6.1 The Standard Settings Menu
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foil is moved as little as possible in order to maintain the repeat accuracy as

high as possible. This option is especially necessary with cutters with friction

roll drive or when milling.

The output speed is slightly reduced with this setting.

Plot to file

This option does not lead the output of the data to the connected device but

opens a dialog in which the path and the name of an output file can be given

that will be saved to the hard disk.

Read out automatically

This option can be activated if a device is connected and "online" and a read

out command for this device exists in the driver.

Output only tool-assigned layers

This option takes care that only objects are output where a tool assignment

to a layer was done.

please refer to 3.2.2: Tool Assignment Via Layer

Weeding border

This option defines if and with which distance a weeding frame is cut around

the output objects. This option facilitates the weeding of foil.

Overlap

It defines the overlapping of two segments. This value takes for example

care of the compensation for the shrinking that occurs with foils.

Copy spacing

Copy distance defines the distance of copies on the output medium.

Segment spacing

Segment distance defines the distance between single segments of a job.

Stack spacing

Stack distance defines if copies shall be stacked vertically. Requirement for

the activation of this option is that the selected object can be output more

than once on top of each other.

Indication: In the output-preview the first object is shown "normally".
Each further object of the stack is shown with a black square filled with

an X.
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No tooltips

This option takes care that no tooltips that were entered in the device driver

are shown in the output dialog.

4.6.1.4 The Register / Jog Marks… Setup

Via this menu item the size, the position with regard to the selected object

and the kind of register / jog and video marks can be determined. 

Indication: The register / jog marks function serves for the

determination of marks that are needed for the contour cutting.

4.6.1.5 The Filter Setup

Auto import selection

This setup allows to define the search paths for the import as well as to

select the file name for the automatic import of files (F12) and if the file is to

be deleted after the import.

The Autoimport works as follows:

If GreatCut is loaded and an EPS file is saved in one of the given search

paths under the defined name (for example GreatCut), then it activates

automatically GreatCut and this file will then be loaded directly to the

working surface.

For the import of data from CorelDRAW, Illustrator, AutoCAD and

Freehand an automatic export named CoRUN is implemented.

please refer to 2.3: Autoexport - Scripts

Turn off preview for

Here, the size that the bitmap-files (TIF, JPG, BMP, PCX, …) and/or EPS

files may have so that they are shown in the import-preview can be defined.

Reason:  When unintentionally selecting a huge file, unnecessary waiting

times can occur.

DXF, HPGL Import

Close objects

If activated, the vector objects whose distance from start and end point are

within the closing tolerance are closed respective connected automatically

when importing.

4.6.1 The Standard Settings Menu
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Close tolerance

In an entry field the value for the maximum distance from the start and

endpoint up to where the objects are closed respective connected is to be

entered.

All layers

If this option is activated all layers are considered when automatically

closing otherwise only the ones in the adjoining list.

Combine objects from same layer

If this option is activated all closed objects in the same layer are combined

during the DXF-/HPGL-import.

Export via clipboard and drag'n drop

Create additional EPS format

If this option is activated an additional EPS-format of the selected objects is

created when exporting via clipboard or drag'n drop.

After import

Fit working area to objects with following margin offsets

If this option is activated the working area is adjusted to the imported objects

when importing.

When working with GreatCut all distances between copies are calculated by

means of the paper size.

Fix object size

If this option is activated all imported objects are provided with the object

attribute "fixed object size". Thus the size modification is deactivated.

Fix object size for output

If this option is activated all imported objects are provided with the object

attribute "fixed object size for output". If this option is active no size

compensation takes place during the output. The objects are only positioned

and rotated after the reading of the marks.

Separate layers by names

If this option is activated, for each color that has a not yet existing layer

name a new layer is created. Thereby, same layer names are put in one

layer.

4.6.1 The Standard Settings Menu
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At PDF Export

Integrate JOB file into PDF file on eport

If this option is activated, the job file from the current window is embedded

into the PDF file while PDF export.

Indication: The job file can be loaded at import separately.

No page selection on Import

If this option is activated, the page selection when importing a PDF file is

suppressed - the page selection dialog will be skipped.

please refer to 3.2.1.1: Import

4.6.1.6 The RIP… Setup

Standard RIP

Two particular RIPs are meant as extensions to GreatCut 4: EuroVPM and

Pjannto RIP.

EuroVPM Option

This option must be enabled from the EuroVPM licensee. Using the ...

button, goes to the folder containing the EuroVPM.exe file.

Pjannto RIP Option

This option must be enabled from the Pjannto RIP licensee. In GreatCut no

more settings have to be done.

4.6.1.7 The Profile... Setup

The Profile... setup serves the customization of the desktop. The user or administrator

can adapt the GreatCut interface to fit his needs or restrict it to its necessary amount. The

so defined user profile can be exported or be transferred - provided with a password

protection - onto other licensed client computers.

4.6.1 The Standard Settings Menu
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4.6.1.7.1 Presentation

The following options are possible: Original, XP, Icy, Office (colored). Changes

are executed directly.

4.6.1.7.2 Color

The following options are possible: Blue, Siver, Olive, and Red. Changes are executed

directly.

4.6.1.7.3 Menu Icons

Possible sizes are: Small, Medium and Large. A preview in the left hand area of the

dialog shows, what effect the changes have.

4.6.1.7.4 Toolbar Icons

Possible sizes are: Small, Medium and Large. A preview in the left hand area of the

dialog shows, what effect the changes have.

4.6.1 The Standard Settings Menu
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4.6.1.7.5 Lock Dialog with Following Password Option

If here a password is assigned, this password is queried while the activation of the Profile

Menu Item. Changing the view is only possible with the known password.

4.6.1 The Standard Settings Menu
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4.6.1.7.6 Export Profile Button

Fig. 4.6-1: Save profile dialog with default path

Enabling of the Export Profile button allows saving of customize GreatCut profiles. The

used file extension is *.EC7. As default *.EC7 files are saved in the folder, where the

program data are located.

Note: If all menus or the settings menu were accidentally disabled, then access on
the profile resp. profile file is possible using the sytem menu. The system menu is

enabled with a click on the program logo, which you'll find left from the program
name in the program bar.

Fig. 4.6-2: System menu with Profile… sub menu

4.6.1 The Standard Settings Menu
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4.6.1.7.7 Status Area

In the status area messages and infos are displayed that explain the program's operation.

4.6.2 The Color Palette Command

With this command new color palettes can be created, loaded or saved.

Layer Numbers

If this option is active layer numbers are shown in the layer-toolbar.

Layer Info…

Opens the dialog for the setup of the layer toolbar. Here, you can define

which information is shown if the mouse cursor is positioned above a layer

color.

Possible information is: color-number, RGB values, CMYK values, material

name, mode/tool, material and amount objects. In addition, the amount of

visible layers and the width of the window can be set.

An „I”-button opens a window with shortcuts of the layer toolbar.

Layer Order…

This option opens a dialog for the modification of the layer order respective

the output order.

Only Sel. Layer Visible

If this option is activated only the objects lying in the selected layer are

shown on the working surface.

Delete Sel. Layer

Deletes the selected layer from the layer list.

Delete Unused Layers

This option removes all unused layers, all layers without objects and without

device connection.

New Palette

All color layers that have layer numbers bigger than 6 are removed. You use

this command if you want to define a new color palette individually. The

selection of the layer color is done by just selecting the desired color with

your mouse cursor and then activating the OK button.
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Load Palette…

The previously defined palettes can be loaded.

Save Palette

With this command you save a newly defined or a modified standard palette

on your hard disk. If this new or modified palette is saved as default palette it

will be used at every new start of GreatCut.

Save Palette As…

This command allows the new allocation of a palette name.

Default

This command loads the color palette that is delivered as standard with

GreatCut. It is a Mactac foil color chart that was defined as default palette by

means of the color fan.

Palette History

This function facilitates the loading of the last 4 color palettes without the

detour via the file directory tree. At the end of the menu list of the color

palette menu the names of the last 4 edited color palettes appear. Click with

the mouse cursor on the desired palette name and thus open the selected

palette. 

4.6.3 The Working Area… Command

4.6.2 The Color Palette Command
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Fig. 4.6-3: Working area with shadows and rulers

Here, you can newly define the size and color of your working area. The

working area is displayed as a paper frame with a gray shade on the right

and bottom next to the frame (see figure above). The color of the working

area is freely definable; this guarantees an optimal layout control on the

screen.

Pre-defined are for example DIN-A-sizes. Besides the fix defined measures

you can define any number of user-defined working area. One can be

defined as standard. It will then be pre-set at every "file new".

This option is a very helpful function for everybody who has e. g. a milling or

an engraving machine as the new entry in each case of the usable area can

be omitted.

Indication: A double click on the shade right next and below the
working area also opens this dialog.

4.6.4 The Rulers… Function

With this function you define the positions where the rulers shall be

placed. Due to lack of space the display of the rulers can be

abandoned. With diametric display each 5th step is drawn longer and with

non-diametric each 2nd and each 4th once again.

SHIFT+I
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4.6.5 The Unit of Measurement Function

This instruction switches the measuring unit to the preferred unit (mm, cm or

inch).

Indication: The metric can also be changed directly via a button that is

in the angle of both rulers.

4.6.6 The Undo / Redo Command

With this instruction the undo / redo function can be switched on or off.

Advantages when undo / redo switched off:

With big or many objects the node processing is faster. The testing phase

(initial state -> edition -> temporary final state) with several processing

steps can be made undone as follows:

1. Switch off undo/redo, 2. edit objects and 3. switch on undo / redo

The selection of the undo function in the edit menu reestablishes the state

before point 1.

SHIFT+F7

4.6.7 The Snap Mode Function

The snap mode facilitates the creation of objects at the subsidiary lines. This

option activates the "magnetic" effect on graphic objects and text blocks.
P

4.6.8 The Choose Language… Command

This instruction opens a dialog with which the display language of GreatCut

can be selected.

4.6.5 The Unit of Measurement Function
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4.7 The Window Menu

4.7.1 The New Window Command

Activating this instruction opens a new GreatCut window.

4.7.2 The Tile Horizontally Command

The activation of this instruction places all open windows diminished - one

above the other - horizontally.

4.7.3 The Tile Vertically Command

The activation of this instruction positions all opened windows diminished  -

side by side - vertically.

4.7.4 The Cascade Command

The confirmation of this instruction displays all windows diminished and

cascaded (diagonally displaced).

4.7.5 The Close Command

Clicking this instruction closes the momentarily active window after prior

safety query.

4.7.6 The Close All Command

Clicking this instruction closes all open windows after prior safety query.

4.7.7 The Standard Command

This command switches the tool-toolbar on the desktop or makes it

disappear.
CTRL+1

4.7.8 The Sidebar Command

This instruction switches the so-called Sidebar on or off. The Sidebar

contains several tabs (e. g. layer) and is normally displayed at the right

border.

CTRL+2

4.7 The Window Menu
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4.7.9 The Setup Command

This instruction switches the setup toolbar on the desktop or makes it

disappear.
CTRL+3

4.7.10 The Common Tools Command

This instruction switches the common tools toolbar on the desktop or

makes it disappear.
CTRL+4

4.7.11 The Object Tools Command

This instruction switches the object tools toolbar on the desktop or makes it

disappear.
CTRL+6

4.7.12 The Object Parameters Command

This instruction switches the object parameters toolbar on the desktop or

makes it disappear.
CTRL+7

4.7.13 The Status Bar Object Info Command

This instruction switches the status bar object info toolbar on the desktop

or makes it disappear.
CTRL+8

4.7.14 The Status Bar Element Info Command

This instruction switches the status bar element info on the desktop or

makes it disappear.
CTRL+9

4.7.15 The Active Windows List

At the below part of the window menu instruction list all active jobs are

listed.

Indication: If more than 9 jobs are active it will be indicated by the

menu item: further windows.

4.7.16 The Further Windows… Command

This instruction is only visible if more than 9 windows are active. A window

with a list of all active windows is opened. A click switches to the wanted

window.

4.7.9 The Setup Command

102



4.8 The Help Menu

4.8.1 The About … Command

The selection of this menu entry opens an info window in which various

information is shown. On the left part of the dialog among others the serial

number, version number, free disk space, co-processor, or type of processor

are shown. On the right down part of the dialog is a scroll window in which

all the application files of the respective application version are listed. This

file list can be printed via the print button.

Indication: If there should be problems with your GreatCut version you

can fix them the fastest, if this list is made available to our support

staff.

4.8.2 The Help… Command

This option starts the GreatCut help. F1

4.8.3 The Object Info… Command

The activation of this instruction opens an info window that contains

information about the objects on the desktop. These are among others the

number of objects, number of selections, vector objects, text blocks, all

groups and combinations or all bitmaps.

The selection button opens the object manager.

F10

4.8.4 The Install Autoimport Plug-Ins… Command

Enabling this command opens the Corun Installer window, that lists for

which programs plug-ins are available. Programs which were automatically

found are marked already. Select the target program for the intended data

exchange in the Eurosystems Software list field.

Pressing the Install button starts the installation.

please refer to 2.3.1: Corun Installer

4.8 The Help Menu
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4.9 Context Menu Left Mouse Button

4.9.1 Context Menu Ruler

4.9.1.1 The Unit Button

A click on the Unit button activates one of the following context menus:

Note: Which of the two is enabled, depends on whether objects are selected on the

working area and what zero point setting is active.

 or 

4.9.1.1.1 Origin…

This command opens the following dialog, with which the coordinates of the zero point can

be set manually:

4.9.1.1.2 New Position

4.9 Context Menu Left Mouse Button
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X Field + Measuring Unit

In the X field, the absolute coordinate of the zero point on the X-axis can be specified.

Note: The unit depends on the setting of the ruler.

Y Field + Measuring Unit

In the Y field, the absolute coordinate of the zero point on the Y-axis can be specified.

Note: The unit depends on the setting of the ruler.

Display as Cross-Option

If this option is activated, the origin point is represented by a dashed coordinate cross.

Bottom Left

If this option is activated, the origin point is positioned on the sheet's bottom left corner.

Bottom Right

If this option is activated, the origin point is positioned on the sheet's bottom right corner.

4.9.1.1.3 Move Origin

This command serves to move the ruler origin to any position on the desktop.

4.9.1.1.4 Reset Origin

This command serves to move the origin point into the lower left corner of the working

area.

4.9.1.1.5 Set Origin to Center of Page

This command serves to move the origin point to the center of the working area ( center of

page).

4.9.1.1.6 Set Origin to Center of Selection

This command serves to mirror or place objects at the coordinate axis.

Note: This command is only visible if one or more objects are selected on the

working area.

4.9.1.1.7 Hide Origin

This command serves to switch the ruler zero point to invisible.

4.9.1 Context Menu Ruler
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4.9.1.1.8 Release Origin

This command serves to release the fixation of the ruler origin in order to move it with the

mouse.

4.9.1.1.9 Show Origin

This command serves to switch the ruler zero point to visible.

Note: Only visible, if the Display as Cross-Option is active (see above).

4.9.1.1.10 Fix Origin

This command serves to anchor the ruler zero point at a definite point.

4.9.1 Context Menu Ruler
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4.10 Context Menus Right Mouse Button

4.10.1 Context Menu on Empty Working Area

Fig. 4.10-1: This menu appears if no objects lie on the desktop

Text components

This instruction opens the Text components dialog.

Refresh screen

This instruction refreshes the main window.

Import…

This menu entry opens the import dialog for the import of external file formats.

Insert

This menu entry inserts contents from the Windows clipboard to the GreatCut working

area.

Working area

This menu entry opens the dialog for the pre-setting of the parameters of the working area.

4.10 Context Menus Right Mouse Button
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4.10.1 Context Menu on Empty Working Area
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5 Reference Part Output Preview

5.1 The Output Menu

5.1.1 The Output Command

Starts the output on the connected device with the settings of the output to device

dialog.

5.2 The Options Menu

5.2.1 The Save As… Command

The save as… command in the output preview ... saves the job

with all changes that were done in the preview. When returning to

the working surface all these settings would be lost, therefore, the

job can here be saved under another name.

please refer to 4.1.4: The Save as… Command

SHIFT+CTRL+S

5.2.2 The Rotate Axis Command

This command rotates the marked objects at 90° counter-clockwise.

please refer to 4.3.1: The Rotate Axis Command A

5.2.3 The Horizontal Mirror Command

The selected object is mirrored at the horizontal through its center-point.

please refer to 4.3.3: The Horizontal Mirror Command X

5.2.4 The Vertical Mirror Command

The selected object is mirrored at the vertical through its center-point.

please refer to 4.3.4: The Vertical Mirror Command Y

5.2.5 The Optimization… Command

The foil optimization takes care that all objects are arranged in a way that they take the

least space on the foil. By rotation or no rotation of objects it is taken care of, that the

material waste can be decreased.
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please refer to 4.5.6: The Optimize Material… Function
please refer to 3.5: Cutting - Milling - Creasing - Drawing …

5.2.6 The Sort With Simulation… Command

This command opens the sort objects function with which the output

order and the direction of rotation can be defined. The sortation can de

done dependent or independent on layer. Also, the preferred direction of

the sortation can be defined.

In a preview window the output of the objects is simulated graphically;

here, the traverse paths of the tool head can also be drafted. The

simulation can be done unlimited without changing the original objects.  

CTRL+F10

please refer to 4.3.16: The Sort With Simulation… Command

In detail: please refer to 7.5: The Sort With Simulation… Tool

5.2.7 The Recalculate Command

The recalculate command enables the modification of the

output-parameters or of the driver settings without leaving the output routine.

This command switches back from the output preview to the output dialog.

N

5.2.8 The Initial View Command

Puts back the output preview to the status before having pressed the

preview button in the output dialog. All changes are made undone. 
SHIFT+N

5.2.9 The Horizontal Weeding Lines Command

Weeding lines serve for the better processing of big jobs. Material lengths of

several meters in length or width are difficult to handle, therefore you can

insert weeding lines during the foil cutting that divide the job into smaller

parts that are easier to handle.

The horizontal weeding lines are set with the hotkey "h" or drawn with the

arrow from the weeding frame dashed in blue.

please refer to 3.5: Cutting - Milling - Creasing - Drawing …

H

5.2.10 The Vertical Weeding Lines Command

Weeding lines serve for the better processing of big jobs. Material lengths of

several meters in length or width are difficult to handle, therefore you can

insert weeding lines during the foil cutting that divide the job into smaller

V

5.2.5 The Optimization… Command
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parts that are easier to handle.

The vertical weeding lines are set with the hot key "v" or drawn with the

arrow from the weeding frame dashed in blue.

please refer to 3.5: Cutting - Milling - Creasing - Drawing …

5.2.11 The Test Drive Command

If the test drive command is activated the connected device goes with lifted tool head

along the weeding frame. This also happens if the option "weeding frame" was not

activated.

Compare test drive button in the output dialog please refer to 3.5: Cutting - Milling -
Creasing - Drawing …

5.3 The View Menu

5.3.1 The Material Width Command

When activating this command the section is adjusted to the values for the

material width defined in the driver or set in the output dialog.
B

5.3.2 The All Objects Command

This function changes the display in that way that all objects can be seen on

the screen. The section is selected so that it is the biggest possible display

showing all objects.

If, while activating this command the SHIFT key is pressed, only the marked

objects are zoomed to maximum.

F4
and

SHIFT+F4

5.3.3 The Selected Objects Command

If this command is activated only the selected objects from the output

preview are displayed as large as possible.  
SHIFT+F4

5.3.4 The Total Area Command

If this menu item is activated the preview of the whole material surface is

shown.

The size of the shown surface depends on the so called frame size (foil

height x foil width) of the output device to be accessed.

If in the output dialog a driver for a friction feed cutter was selected, in the

preview always a material length of 30m (32,81 yd) is shown. 

SHIFT+B

5.2.10 The Vertical Weeding Lines Command
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If in the cutting dialog a driver for a flatbed cutter was selected, the

maximum width of the flatbed cutter is shown as material length.

5.4 The Window Menu

5.4.1 The New Window Command

Activating this instruction opens a new GreatCut window.

5.4.2 The Tile Horizontally Command

The activation of this instruction places all open windows diminished - one

above the other - horizontally.

5.4.3 The Tile Vertically Command

The activation of this instruction positions all opened windows diminished  -

side by side - vertically.

5.4.4 The Cascade Command

The confirmation of this instruction displays all windows diminished and

cascaded (diagonally displaced).

5.4.5 The Close Command

Clicking this instruction closes the momentarily active window after prior

safety query.

5.4.6 The Close All Command

Clicking this instruction closes all open windows after prior safety query.

5.4.7 The Common Tools Command

This instruction swithes the Common Tools toolbar on or off. CTRL+4

5.4.8 The Object Parameters Command

This instruction switches the object parameters toolbar on the desktop or

makes it disappear.
STRG+7

5.3.4 The Total Area Command
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5.4.9 The Status Bar Object Info Command

This instruction switches the status bar object info toolbar on the desktop

or makes it disappear.
CTRL+8

5.4.10 The Status Bar Element Info Command

This instruction switches the status bar element-info on the desktop or

makes it disappear.
CTRL+9

5.4.11 The Active Windows List

At the below part of the window menu instruction list all active jobs are

listed.

Indication: If more than 9 jobs are active it will be indicated by the

menu item: further windows.

5.4.12 The Further Windows… Command

This instruction is only visible if more than 9 windows are active. A window

with a list of all active windows is opened. A click switches to the wanted

window.

5.5 The Help Menu

5.5.1 The About … Command

The selection of this menu entry opens an info window in which various

information is shown. On the left part of the dialog among others the serial

number, version number, free disk space, co-processor, or type of processor

are shown. On the right down part of the dialog is a scroll window in which

all the application files of the respective application version are listed. This

file list can be printed via the print button.

Indication: If there should be problems with your GreatCut version you

can fix them the fastest, if this list is made available to our support

staff.

5.5.2 The Help… Command

This option starts the GreatCut help. F1

5.4.9 The Status Bar Object Info Command
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5.5.3 The Install Autoimport Plug-Ins… Command

Enabling this command opens the Corun Installer window, that lists for

which programs plug-ins are available. Programs which were automatically

found are marked already. Select the target program for the intended data

exchange in the Eurosystems Software list field.

Pressing the Install button starts the installation.

please refer to 2.3.1: Corun Installer

5.6 Context Menu of The Right Mouse Button

5.6.1 Context Menu Output Preview

Fig. 5.6-1: Context menu of the output preview with weeding frame function

Weed border

This function creates a weeding frame around the selected objects in the output preview

unlike the weed border option.

All other menu entries can be activated via the main menu.

5.5.3 The Install Autoimport Plug-Ins… Command
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6 Toolbars

6.1 The Standard Toolbar

The standard toolbar is switched on or off via the window menu. CTRL+1

Fig. 6.1-1: Freely placeable toolbar - Collection of standard tools

Fig. 6.1-2: Fixed standard toolbar

BUTTONS FROM 1 TO 15

1. Create New window 9.  Print objects
2. Open job 10. Import file
3. Save job 11. Export objects
4. Save all 12. Scan image
5. Edit job info 13. Undo

6. Cut to Clipboard 14. Redo

7. Copy to Clipboard 15. Help

8. Paste from Clipboard

6.2 The Setup Toolbar

The Setup toolbar is switched on or off via the Window menus. CTRL+3

Fig. 6.2-1: Free placeable Setup toolbar

Fig. 6.2-2: Fixed Tool Bar

BUTTONS FROM 1 TO 2

1. Contour mode on/off
2. Desktop Setup

Indication: Alternatively the work area can be defined by doubleclick on the shades
beside the work surface.
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6.3 The Object Tools Toolbar

The Object Tools toolbar is switched on or off via the WIndow menu. CTRL+6

Note: This is the section which in former GreatCut versions (right mouse click for

icon assignment) was the variable section of the object toolbar. 

Fig. 6.3-1: Freely placeable toolbar - collection of objcet tools

Fig. 6.3-2: Anchored toolbar

BUTTONS FROM 1 TO 21

1. Delete Objects 12. Open Objects
2. Do Axis Change with Objects 13. Round Objects
3. Horizontal Mirror of Selected Objects 14. Delete Redundant Nodes

4. Vertical Mirror of Selected Objects 15. Vectorize Objects
5. Group Objects 16. Generate Contour Line

6. Ungroup Objects 17. Start Foil Optimization

7. Combine Objects 18. Set Start Tool Paths

8. Release Combination of Objects 19. Hatch Objects
9. Generate Block Shadow 20. Generate Out- or Inlines

10. Align Objects 21. Weld Objects
11. Close Objects

6.3 The Object Tools Toolbar
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6.4 The Object Parameter Toolbar

Fig. 6.4-1: Freely placeable toolbar - collection of object parameters

Fig. 6.4-2: Object parameters toolbar with explanations

6.4.1 The Multi Copy Command

Definition: Multi Copy = Multiple copies of selected objects (Duplicates)

6.4.1.1 The Multi Copy Button

Pressing the button opens the following dialog:

6.4.1.2 Copies X:

Using the   or   button the number of duplicates can be increased or decreased in

increments of one. The alignment is done in the Main Direction. Alternatively, any integer

value may be entered in the field.

6.4 The Object Parameter Toolbar
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6.4.1.3 Copies Y:

Using the  und -button the number of duplicates can be increased or decreased in

increments of one. The alignment is done in the Main Direction. Alternatively, any integer

value may be entered in the field.

6.4.1.4 Offset X:

This value determines the distance between the duplicates in X-Axis direction.

6.4.1.5 Offset Y:

This value determines the distance between the duplicates in Y-Axis direction.

6.4.1.6 The Select Objects Option

If this option is enabled, all duplicates will be selected finally. 

6.4.1.7 The Fill Working Area Option

If this option is enabled, then the working sheet only and not the desktop is filled with

duplicates.

Note: Enabling this option, de-activates the Copies X and Copies Y fields.

6.4.1.8 The Create Clones Option

If this option is enabled, then the selected object is uses as control object for cloning. All

duplicates are generated as clone objects.

6.4.1.9 The Group Result Option

Enabling this option groups all duplicates finally.

6.4.1.10 The Optimize Traverse Path Option

If this option is enabled, duplicates are generated in meanders. This reduces the head

movement of the output device and shortens the output process.

Note: The main direction option defines additionally, if meandering is done in X-Axis

or Y-Axis direction.

6.4.1.11 The Main Direction Option

The  button sorts the duplicates in Y-Axis direction - "column by column". The

-button sorts the duplicates in Y-Axis direction - "line by line".

6.4.1 The Multi Copy Command
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6.5 The Status Line Object Info

This status line informs about the properties and attributes of objects on the GreatCut

desktop. This information comprises number, type of object, color model, color value and

many other data important for the evaluation. 

Fig. 6.5-1: Status line for the display of object properties, color spaces , etc. - free floating

Fig. 6.5-2: Status line for the display of object properties, color spaces, etc. - fixed

6.6 The Status Line Element Info

This status line indicates the current mouse cursor position in x/y-coordinates. In addition,

in the left part next to the cursor coordinates subsidiary texts and additional texts from the

layer info for example from the field material name are displayed. It is also possible to

show driver information as for example the set tool depth for a particular layer.

Fig. 6.6-1: Status line element with subsidiary texts and element information, here

coordinates

6.7 The Preview Tools Toolbar

The Arrow Tool

This mode allows you to mark, move, group temporarily (marking function)

and modify the size of objects in the output preview.

SPACE

The Magnifying Glass+

The button with the (+) plus sign increases parts of the output preview. Draw

with the marking function a frame around the area that shall be increased.

This function can be carried out successively several times until a beep

reminds acoustically of the last possible step.

F2
or

+(Num)

The Magnifying Glass–

The button with the (-) minus sign decreases gradually parts of the desktop

or of the working area.

F3
or 

-(Num) 

The Sheet  B

6.5 The Status Line Object Info
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The button with the symbolic sheet of paper shows the material area

increased to the maximum

The Screen

The button that symbolizes a screen displays all objects on the material area

as big as possible. The section is thus selected that is it the biggest possible

display with all objects visible.

 F4

The Magnifying Glass for Selected Objects

The „dotted loupe” button displays all selected objects as big as possible.

SHIFT +

F4

The Measure Tool

This tool serves for the determination and the percental modification of

object dimensions.

 M

The Output Command

The activation of this button gives the data to the Plot-Manager for the

output to the connected device.

 S

6.7 The Preview Tools Toolbar
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6.8 The Preview Object Parameters Toolbar

The preview object parameters toolbar is activated with the following

shortcut.
CTRL+7

Indication: It is identical with not variable part of the object parameters toolbar in

previous GreatCut versions.

Fig. 6.8-1: Object parameter toolbar with position, size, angle, multi copy, …

Note: The display of the object parameters toolbar varies depending on how the

object properties are set!

6.8 The Preview Object Parameters Toolbar
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6.8 The Preview Object Parameters Toolbar
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7 Tools

7.1 The Desktop

After starting GreatCut the desktop with the working area appears as follows:

Fig. 7.1-1: GreatCut Desktop with working area and shown tool-toolbar, rulers, Object

Manager and status lines

The working area is marked by a black frame that has on the right and below a gray

shade. The working area serves for the orientation and dimensioning.

The rulers can be freely positioned or completely switched off. The layer toolbar is

integrated into the Sidebar. The metric (cm, mm, inch) can be directly changed via a

button that is within the angle of the two rulers. Also ruler's origin can be changed.

Following options are available: Set Origin to Absolute Coordinates, Move Origin, Reset

Origin, Set Origin to Center of Page, Show Origin and Release Origin.

In the status line you find much information about the objects on the working area. For

example the wire frame, filling, object dimensions, -number, combination or grouping

are displayed.
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7.1.1 Cursor forms on the working area and their meaning

Cursor form Meaning

no object marked or selected

Indication: You mark objects by positioning the mouse cursor above the object and

pressing the left mouse button.

Cursor form Meaning

Move objects

Indication: This cursor is only active if the cursor is within the range of the inner

part of the object or in the range between the 8 black squares on the wire frame

line. The object must be marked.

Cursor form Meaning

Increase object vertically

Increase object horizontally

Increase object diagonally

Indication: The cursors for the modification of the object size are only active if the

cursor is within the range of the 8 black squares on the wire frame line of the

object. You switch to the skewing-/rotation-mode by clicking with the left mouse

button with active cross cursor (see above move objects).

Cursor form Meaning

Object in the skew/rotate-mode

Rotate object

Skew object (set tilted horizontally/vertically)

7.1.1 Cursor forms on the working area and their meaning
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7.2 The Outline Function

This function is activated via the  button in the variable part of the object

parameter toolbar or via the tools menu, menu entry outline…
O

The outline function creates contours in a freely definable distance around graphical and

text objects.

Fig. 7.2-1: Outline parameter window

Offset

The value for the distance of the inline and outline from the original object are entered in

the field offset.

Copies

The option copies indicates how many in- or outlines shall be created simultaneously at a

function call.

Automatic welding

Automatic welding means that all overlappings of in- or outlines shall be removed so that

a closed contour is created.

Delete original

If the button delete original is activated the original object is deleted after the creation of

the contour.

The corner treatment can be influenced via three additional options.

Do not modify corners

The option do not modify corners creates the mathematical accurate dot on the outline

to each corner dot. This leads to the fact that in pointed corners the outline is extended

7.2 The Outline Function
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endlessly which often leads to unaesthetic results. Therefore the option cut corners is

pre-defined as default. This option shortens the extension to the value that is entered in

the field tolerance.

Round corners

Round corners transfers the corner dot in a rounded curve. The field tolerance indicates

in which offset from the corner dot is cut respectively rounded.

Delete objects smaller than

Delete objects smaller than defines the size of a filter that deletes automatically small

and smallest "rejects" that might occur at the creation of an outline. The cumbersome

welding of smallest parts thus can be omitted.

7.2 The Outline Function
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7.3 The Undo Redo Stack

The undo redo stack is activated via following key combination:

These functions can undo or redo all object-related actions.

SHIFT+F5
or SHIFT+F6

Indication: actions that refer for example to the working area, the desktop or the

layer-toolbar are not taken into the stack.

The pre-settings in the settings menu, submenu miscellaneous

The Undo Redo stack related settings as for example the number of stack actions are

carried out in the following setup dialog.

Indication: The maximum number of the undo steps can only be modified with no

objects on the working area.

Fig. 7.3-1: The parameter of the undo stack (here: marked in red)

The area undo function comprises the settings that effect the undo stack.

7.3 The Undo Redo Stack

127



Fig. 7.3-2: Undo stack with preview window and working area

In the left stack the action can be selected up to which you want to go back. The preview

window shows the status of the working area and of the objects on the working area at the

moment of the action.

The redo stack operates in the same way.

7.3 The Undo Redo Stack
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7.4 The Alignment Function

Fig. 7.4-1: The alignment button

This function aligns two or more marked objects to each other or to the working area.

Fig. 7.4-2: The alignment dialog

Objects can be aligned horizontally or vertically. A centered alignment is also possible as

the selection of the same distance between the marked objects. The type of alignment is

illustrated by icons. Setting can be stored by pressing the Save settings button.

Indication: The last marked or drawn object serves for alignment as reference
object, that means that all others are aligned in the same way. If alignment is not

'Align to Page', then alignment will refer to the last selection.

7.4 The Alignment Function
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7.5 The Sort With Simulation… Tool

This tool serves for the sortation of objects and the determination of sequences before

the output at the connected device. A simulation with or without complete path of the

device tools facilitates the estimation of the results.

Fig. 7.5-1: Object-sortation with preview-window and simulation option

7.5.1 Simulation

The operation of the simulator is similar to a DVD-player.

Lo (low) up to Hi (high) regulates the speed of the simulation display.

Indication: Before simulation, in addition to orientation, you have to do sorting by
clicking on the sort button.

7.5 The Sort With Simulation… Tool
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Fig. 7.5-2: Option show traverse path (lines dashed in blue) activated

Color bar

A click on the wanted color bar selects the respective color layer.

Select all

Selects all objects of the list.

Deselect all

Deselects all objects of the list.

Toggle rotation

This option modifies the orientation from clockwise (right) to counterclockwise (left) and

vice versa.

View selection

Shows the selected objects in the preview window. 

Single selection

In the list only one object can be selected; the multi-selection (standard) is deactivated.

View complete path

A line dashed in blue shows the track that the tool head covers.

7.5.1 Simulation
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Sort layer by layer

All layers

This option comprises all layers to the sortation if sort layer by layer was activated.

Indication: This option is, depending on the driver setting, deactivated in the output

preview

Selected layer

This option comprises only to the selected layer to the sortation if sort layer by layer was

activated.

Max. deviation in … mm

In the input field the value for the maximum deviation of the thought vertical respective

horizontal line that an object may have in order to be sorted can be entered.

Main direction

16 methods can be activated as main direction for the sortation. The icon shows with a red

arrow where sortation beginns.

Sort

Only the sort button activates the object sortation. Then you can check in the simulation if

the sortation meets the demands.

Reset

Resets the objects in the sort-list to the initial value.

7.5.1 Simulation
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7.6 The Welding Tool

This function is activated via the  button in the variable part of the object
parameter toolbar or via the tools menu, menu entry welding…

W

This function welds two or more vector objects with each other to a combination.

Depending on the number and the form of the selected objects you can choose between

the following options: manually, automatically, by color, full area or screen printing.

Fig. 7.6-1: Tools menu - welding submenu

Dialog…

The activation of this submenu opens the following dialog

Fig. 7.6-2: Welding dialog

Manually

Manually separates all intersections that occur because of the overlapping of outlines and

creates object parts. With the arrow-function you mark the object parts that you want to

remove. With the DEL-button the selected object parts are deleted. Overlapping-free

object parts are kept and can later be further edited. The original color of the object parts

7.6 The Welding Tool
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are kept with the manual welding.

Automatically

Automatically calculates the common areas of the objects. All overlapping parts are

combined, transparent interior elements are considered.

Indication: With this option, objects of different colors are welded to a combination

object.

If the object colors shall be considered please select the options by color, full area or

screen printing.

The option automatically is especially suitable for the welding of serifs with scripts. The

serif of the previous letter overlaps often with the successive character. The material

would be slit at these positions without welding. The automatic welding eliminates this

overlapping and takes care of a cuttable transition in the serifs.

Tip: If single parts are missing after the automatic welding, then reduce the

character spacing in the text editor from 100% to 99%. This causes that identical

node dots that lie on top of each other are misplaced so that they are recognized

also as single nodes and the welding routine is carried out properly.

By color

By color removes all areas that are hidden by colors lying above. It does not matter how

many objects and colors you select. If open objects are also selected they can be closed

or provided with a line weight.

Full area

The option full area underfills objects of one color whose areas hide those of another. To

do this, the partially hidden objects are modified so that they underlay completely the ones

lying above. Here, you can also proceed with the open objects as described under

automatically.

Tip: The mostly used field of application is the showcase labeling where the by

color-option is often too laborious to be pasted over. With 2 maximum 3 foil colors
you take the full surface option where the single foil colors are pasted above the

other.

Screen printing

The welding option screen printing is an especially efficient tool for the screen printer. At

first, the overlappings of the single coatings are removed. Then, the colors are layered

according to the sequence in the field color sequence. At the end, a small bar is inserted

at the seams between the single color layers as overlapping.

The color stack with the screen printing-welding
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Modification of the color stack: With the screen printing, the printing sequence is from

bright to dark. Brighter colors are printed before the darker colors. By mouse click a

coating is grabbed and drawn to the wanted position.  The color stack reflects the position

of the layers above the medium. The output sequence considers the modifications of the

color stack.

Provide open objects with contour … mm

If open objects are amongst the selected you can indicate with the option provide open

objects with contour …  which thickness the created closed object shall have.

Do not correct appearance of combinations

With this option combinations are treated that they are welded as displayed in the full

surface mode. Overlays in combinations remain transparent.

Join same colors

It can happen that the same color reappears in different group- or combination objects.

Then, select the option join same colors so that those merge to one color layer.

Indication: This is especially important with the creation of screen printing

templates as with the screen printing process the darkest color is always spread at

last in order to prevent possible white gap that might occur while mounting the

single colors.

Remove identical lines

With this option all vectors that are identical are removed but one.

7.6.1 Seams

Underlap - Offset

These options can only be activated with by color. In the field overlay you can enter the

value for the underlap or the offset.

Overlay … mm

If the option screen printing is activated you can enter here the value for the overlay of

the colors in mm.

Complete overlay up to:

Here, you can additionally enter the limit up to which width it shall be completely overlaid.  

7.6.1 Seams
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7.7 The Measure / Measurement Tool

Fig. 7.7-1: The measure / measurement button

Activate the measure button in the toolbox with the mouse pointer. Return to the working

area; the mouse pointer appears as circular sight. Move the center point of the sight to the

starting point of the track to be measured. Keep pressed the left mouse button while

moving to the end point of the track and let go the mouse button when you have reached

the end point. A subsidiary line marks the measured track.

Indication: Keep pressed the SHIFT key during the measurement. Then the

measurement is limited horizontally or vertically. This facilitates the exact

measurement of straight lines.

Fig. 7.7-2: The measure/measurement dialog

In the text field name length the result of your measurement appears. In order to modify

this value, first mark the text field and then enter the new value. In the text field

underneath you can percental increase or decrease the objects.

In addition, you get information about the angle of the measure lines, the width of the

measured object at the starting point of the measurement and the difference in height

between the starting and the end point that is resulted from the measure angle.

Measurement

Fig. 7.7-3: Measurement tool / track

The measure lines button changes to the measurement tool (see illustration). This tool is

attached to the mouse cursor and can be moved to the wanted position. After letting go

the mouse button the detected track is entered above the measurement track.
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Fig. 7.7-4: Measurement track with the detected value in mm

Indication: The default size of the dimension text can be set via the settings /

standard settings / miscellaneous... menu.
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7.8 The Contour (Line) Function

With the contour line function the outer edge of arbitrary many objects is calculated and

provided with a wire frame line. Contrary to the outline you can contour also bitmaps with

this tool. In addition, not every single object is outlined. Instead, it is tried to possibly find

one contour that comprises all selected objects. This function is therefore especially suited

for the creation of cutting lines around labels. The objects of the label can be arranged

arbitrarily.

Then the wire frame of the object is calculated in the wanted distance with the tool

described here. The contour line thus created can be used later for cutting out the printed

label.

First select the objects that you want to contour / outline. Then select contour… in the

tool menu.

The following dialog for the creation of the parameters appears:

Fig. 7.8-1: Parameter dialog for the creation of contour lines

Find contour

With the fields in the dialog group find contour you can influence the calculation of the

wire frame line. Generally, all objects that are not white are considered with the contour

finding. Ideally, the background of the graphic to be contoured should therefore be white.

But especially bitmaps contain often light gray spots that can occur when scanning.

Maximum gray scale

With the option maximum gray scale you can determine that gray spots above the

selected intensity are not contoured. You can enter values between 50 and 99% or set

them with the roll bar. 50% correspond to a relatively dark gray and 99% to an almost

white color.

7.8 The Contour (Line) Function
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Accuracy

In the field accuracy you can select between three options. The low accuracy works the

fastest. If the result is not satisfying with this setting, select the middle or a higher

accuracy. The calculation of the contour line then takes a little bit longer.

Indication: The field accuracy is not activated if only a single bitmap was selected.

Keep interior elements

If the option keep interior elements is activated, possibly created interior elements are

not deleted. This way you have the possibility to cut out parts of the graphic by applying a

brighter "plaster".

Look at the following illustration for this:

Fig. 7.8-2: Option: keep interior elements

On the left side you see the two initial objects. A smaller white circle is put onto the black

circle. On the right, the calculated contour line is displayed. The option keep interior

elements was active, also the inner circle was considered at the contour finding. With the

dialog field switched off, only the outer contour would have been created.

Indication: As default, keep interior elements should be switched off.

Distance and line guidance

In the second dialog group distance and line guidance you can influence the

appearance of the contour line.

Contour offset

With contour offset you determine how far away the wire frame line shall be from the

graphic. If you enter here the value "0" a contour line is created that directly is attached to

the edge of the selected objects. With values smaller than 0 the contour line goes into the

contoured objects.

Corner shape

The option corner shape determines how the contour line acts at salient corners.

Normal creates the mathematical exact dot on the contour to every corner dot. The

contour line can thus be extended very long at sharp corners which often leads to

unaesthetic results. The options cut off and round lead to more satisfying results in such

cases.
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Cut off

Cut off shortens the contour at the indicated distance and cuts off the corner by a section.

Round

Round leads the corner dot to a rounded curve.

Color

On the right side of the dialog you can see a color selection field. A click on the change

button opens the color selection dialog. With this dialog you can allocate colors to

contours.

Destination Layer

This Field determines in which color layer - in doing so indirectly, with which tool - the

contour line is processed.

Note: The contour line color can be different in the full surface mode (print) and the

contour mode (output).

7.8 The Contour (Line) Function
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7.9 The Plot Manager

The Plot Manager has the following tasks:

7.9.1 Creation And Modification of Device Configurations

With the Plot Manager it is possible to create a device configuration or short, to create an

output device. In a device all information necessary for the output of the data as for

example driver and ports are summarized.

In GreatCut, these devices then can be used for the output of the graphics. It is possible,

to output simultaneously at several devices.

7.9.2 Monitoring the Output Processes of the Jobs

The outputs to the respective devices can be monitored with the Plot Manager, for

example the output can be broken or aborted and the sequence of the jobs can be

changed retroactively.

7.9.3 Output of Data to Local Ports

The serial and parallel ports of the computer are identified and can be used for the file

output.

7.9.4 Administration of Hotfolders

A function independent of GreatCut is the administration of Hotfolder. A Hotfolder is a

directory monitored by the Plot Manager. If a file is copied to this directory the Plot

Manager carries out automatically certain configurable functions.

7.9.5 Plot Server Function

The Plot Manager can enable devices so that other Plot Managers can use these enabled

devices. This allows separating design and output working places.

Important note:You start the Plot Manager with a double click on the  icon that is
down right of the screen in the task bar.

7.9 The Plot Manager

141



Fig. 7.9-1: Plot Manager main window with job preview down left

7.9.6 Devices Folder

Each device possesses three device folders in which the jobs are shown:

Indication: with jobs, also those output actions are meant that are carried out by

Hotfolders or on local ports.

Devices Folder 1

Active Jobs

All jobs that shall be output as soon as the device is ready are collected in this folder. If a

job has been output completely, the next job is output. If the option „show message

window before output of a job” is active, a notification dialog is shown before each output.

Devices Folder 2

Passive Jobs

If the output device is broken, all jobs to be output are moved to this folder.

Devices Folder 3

 Saved Jobs
Here, all jobs that have been output are saved. The number of the saved jobs can be

indicated in the options dialog of the device. If the number of the saved jobs is reached the

7.9.5 Plot Server Function
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next one to be saved replaces the oldest existing job.

Job Functions

The functions differ according to device folder, device type and job status.

Indication: The functions can be carried out via a context menu.

Functions for jobs at local devices:

Active Jobs

If the job is being output:

Pause

The output of the data is paused. The job is marked with the symbol.

Paused Jobs

Continue

The output is continued.

Set Job to passive

The job is removed from the list of the active jobs and added to the folder of the passive

jobs.

Delete Job

The job is deleted.

Passive Jobs

Activate Job

The job is removed from the list of the passive jobs and added to the folder of the active

jobs.

Delete Job

The job is deleted.

User message: to this job, a notification text can be entered. This information is shown if

the job shall be output respective if it is selected.

Saved Jobs

Activate Job

The job is removed from the list of the output jobs and added to the folders of the passive

or active jobs depending on the setup device.

Delete Job

The job is deleted.

Plot to File

Here you can determine if the job shall be output to a file.
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Save as

Save job data into file before cut data processing.

Functions for Jobs at Plot Server:

Active Jobs

No functions

Passive Jobs

Activate Job

The job is removed from the list of the passive jobs and added to the folder of the active

jobs.

Delete Job

The job is deleted.

User message: to this job, a notification text can be entered. This information is shown if

the job shall be output respective if it is selected.

Saved Jobs

Activate Job

The job is removed from the list of the output jobs and added to the folder of the passive or

active jobs depending to the setup device.

Delete job

The job is deleted.

Save as

Save job data into file before cut data processing.

Functions for jobs at Hotfolders:

Active Jobs
No functions

Passive Jobs

Activate Job

The job is removed from the list of the passive jobs and added to the folder of the active

jobs.

Delete Job

The job is deleted.

User message: To this job, a notification text can be entered. This information is shown if

the job shall be output respective if it is selected.
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Saved Jobs

Activate Job

The job is removed from the list of the output jobs and added to the folder of the passive or

active jobs depending to the setup device.

Delete Job

The job is deleted.

Save as

Save job data into file before cut data processing.

Functions for Jobs at local ports:

Active Jobs

If the job is being output:

Pause

The output of the data is broken. The job is marked with the  symbol.

Paused Jobs

Continue

The output is continued.

Set Job to passive

The job is removed from the list of the active jobs and added to the folder of the passive

jobs.

Delete Job

The job is deleted.

Passive Jobs

Activate Job

The job is removed from the list of the passive jobs and added to the folder of the active

jobs.

Delete Job

The job is deleted.

Notification: To this job, a notification text can be entered. This information is shown if the

job shall be output respective if it is selected.

Saved Jobs

Activate Job

The job is removed from the list of the output jobs and added to the folder of the passive or

active jobs depending to the setup device.
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Delete Job

The job is deleted.

Plot to File

Here you can determine if the job shall be output to a file.

Save as

Save job data into file before cut data processing.

7.9.7 Settings of the Plot Manager

Fig. 7.9-2: Optional parameters for the Plot-Manager

If the option is activated Plot Manager always on top, the Plot Manager window remains

always in the foreground.

If the option tooltips is activated, a short description to a dialog element is shown if the

mouse pointer remains above the dialog element.

If the option view job preview is activated a preview of the output data is shown.

Command line parameters

If the Plot-Manager is started without parameters it checks all devices if there are jobs for

processing.

If a job was found it is carried out. It stops if no jobs were found or if all jobs have been

processed.

If, when calling up the parameter !SPOOL! is given, the Plot Manager remains active. It

then has to be terminated manually with a right mouse click onto the symbol in the

taskbar.

Hotfolder

With a Hotfolder a directory can be monitored. If a file is copied to the directory to be

monitored one of the following actions is carried out automatically depending on the

settings:
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Fig. 7.9-3: Example for setup devices of a Hotfolder

Settings

Hotfolder name: here you have to enter the name of the Hotfolder

File mask: here, the file name ending are given, that shall be considered, for example *.plt.

Hotfolder directory: here, it is determined which directory the Hotfolder shall monitor.

Output

COM/LPT: the file is output to a local serial respective parallel port.

USB: the file is output to a USB device. A USB device is only shown if it is connected with

the computer.

TCP/IP: the file is send to a TCP/IP address. With some addresses, you additionally have

to enter the right port number.

Spooler: the file is output via a printer driver.

File: the file is copied to the output directory. An existing file with the same name is

overwritten.
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After having carried out the action, the input file is deleted.

Indication: if "file" is set as output, the application is started after the copy. In all other

cases, the application is started before the output.

Extended Settings

Start application if Hotfolder becomes active: in addition, another application can be

started that shall further process the input file to be processed. The file name is marked

with %s.

RIP: only necessary if Pjannto RIP uses this Hotfolder as RIP Hotfolder.

Mask: formatting of the output file name: %File file name; date/time: %Y -

%d_%H-%M-%S year/month/day: hour/second/minute

Change defaults: prevents that the user modifies the output parameters accidentally.

7.9.7.1 Device Options

In the Device Options window you can set - for each device which is listed in the Plot

Manager - the following device options.

Note: This window will be enabled by clicking with the right mouse button on a

device item and selecting the Options menu item.

Fig. 7.9-4: Additional options for each device

Maximal number of saved output files

The registered value of this option limits the number of saved output jobs for this device in

the history of stored files.

Number of outputs (of a Job)

The registered value of this option defines how often active Jobs will be given out.
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Inform user before output

If this option is enabled, then a message window will be shown, before the outputting of

each Job. This gives the user the opportunity to prepare the machine before the data

output.

Plot to File

If this option is enabled, then the output is redirected to a file. Before writing the file to the

Job Save As dialog is enabled.

Activate Sound Signal

If this option is enabled, then an individual sound signal will be given out before each

output of a Job, in order to draw attention to the user.

A sound file in the WAV file format can be selected using the  button.

The Movement... Button

Fig. 7.9-5: Distances of the used tools

This feature tracks the distance (tool motion), from every tool of the activated output

device in meters. In addition to the distance, date and time of each output are given.
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7.10 The PhotoCUT Function

PhotoCUT creates vectors out of bitmaps. PhotoCUT calculates from Windows bitmap

files (*.BMP, *.PCX, *.TIF) raster strips or patterns that can be output with a cutting plotter.

The picture is divided in logical pixel and the average gray value detected for each of

these logical pixel. A picture is created that has fewer pixels than the original. Then,

horizontal or vertical strips, circles, squares, ... are created from this picture whose width is

proportional to the gray value at the respective position.

7.10.1 The PhotoCUT Dialog

Open the PhotoCUT dialog by selecting the so named menu item in the tools menu.

Fig. 7.10-1: Dialog with parameter-setup

General settings

Pixel in X-direction

In this field, enter the number of pixel that shall be combined to a logical pixel in

X-direction. The smaller the value in this field, the better the output quality of the "picture".

7.10 The PhotoCUT Function
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Pixel in Y-direction

In this field, enter the number of pixel that shall be combined to a logical pixel in

Y-orientation. The smaller the value in this field, the better the output quality of the

"picture".

Remaining width

This value determines the remaining width of a strip (only with strips) in mm of the line

respective column size.

Excursion: contrast (adjust via image menu contrast)

Because of the division of the bitmaps into logical pixel the line respective column size is

determined. The width of a strip depends on the set gray value and the contrast. The

maximum width is line respective column size minus the value of the remaining width.

Corresponding to the contrast value the width of the strip is identified by the average

shade of gray. The contrast is the proportion between white and black in %, which means

with 100% contrast the 100% black is mapped on the maximum and 100% white on the

minimum width of the stripe. If the contrast is reduced, the 100% black is only calculated

with for example 50% of the maximum width of the stripe.

Minimum gray value

The Minimum gray value is a limit for the shade of gray. You can for example remove a

constant gray bitmap background.

Indication: This value is only relevant if a graphic is darker than its background.

For all examples the following picture serves as template: (Standard path: C:\Program

Files\GCC\GreatCut 4\Bitmaps\photo.bmp)

Fig. 7.10-2: Template for all following result examples
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Negative

The range of value of the shades of gray is reversed which means that 100% black

become 0% white and vice versa.

Positive Negative

Fig. 7.10-3: Example for the reversion of the range of value

Reverse direction (only with stripes)

If this option is activated, the width of the stripe is aligned downwards.

Width of stripe upwards Width of stripe downwards

Fig. 7.10-4: Example for the reversion of the width of stripe
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Cut out

Width of stripe upwards Width of stripe downwards

Double (only with stripes)

If this option is activated, the width of stripe is created up and down.

Width of stripe up and down

Fig. 7.10-5: Example for „double”

Horizontal or vertical

With the options horizontal or vertical the direction of the stripe is determined.

Bitmap

In the area named bitmap the file data of the template (of the picture) are shown. In the

upper area the width and height of the picture in pixel are indicated and the resolution in

dpi. Underneath, the width and height of the picture are shown in millimeters.

Depending on the functions in the area general settings different effects are created.

Example 1

Following values have been set:

Pixel in X-direction = 1

Pixel in Y-direction = 10

Remaining width = 0

Contrast = 80

Minimum gray value = 0

Orientation = horizontal
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Negative = not active

Reverse direction = no active

Double = not active

Result

Fig. 7.10-6: Result from the value of example 1

Example 2

Following values have been set:

Pixel in X-direction = 3

Pixel in Y-direction = 15

Remaining width = 5

Contrast = 60

Minimum gray value = 0

Orientation = horizontal

Negative = not active

Reverse direction = not active

Double = not active

7.10.1 The PhotoCUT Dialog
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Result

Fig. 7.10-7: Result from the value of example 2

With the 2 examples you can see that already small modifications of the values lead to big

discrepancies with the result.

Weeding aid

Create weeding aid

The stripes at the ends are automatically thickened so that the result can be wed faster.

Stripes per strap

In this field the number of stripes that shall contain a strap can be set.

Width of strap

In this field you define the width of a strap.

For information, underneath these fields the estimated number of objects is shown. This

is important to decide beforehand if the expenditure of time for the weeding is in a

responsible relation to the complexity. 
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Fig. 7.10-8: Example for stripes per strap, width of strap and stripes

The different modi

In the PhotoCUT dialog you can select between following modi: stripes, rhombuses,

circles, rectangles, single rhombuses, single circles, single rectangles.

With which mode you obtain the best and most attractive result depends strongly of the

used template. Templates rich in contrast are usually better suited for optically interesting

results.  

Tip: The screen does not always show a view that enables a reliable evaluation of

the results. Therefore, print the result on your printer. Now you can judge the result

of the procedure relatively exactly and do not risk to waste expensive material!

7.10.1 The PhotoCUT Dialog
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8 The Sidebar

The Sidebar is switched on or off via the Window menu.
CTRL+2

8.1 Term Definition Sidebar

A "sidebar" means a lateral toolbar with tabs. It is comparable to the so-called docking

bars in CorelDRAW. In summary, we find the layer editing (formerly Layerbox), the clip art

manager, object manager, file manager, and the macros.

Functionality of the Sidebar for the user:

The Sidebar summarizes different tools. Previously distributed toolbars such as Layerbar,

Clipart Manager were combined in a compact tab structure. The sidebar serves as a

central element of the object management.

8.2 The Anchorage Control

Fig. 8.2-1: Anchorage control with arrow and dotted line for moving and placing

Note: Only in the docked state, the Anchorage control is activated and visible.

The Collapse Button

Pressing the Collapse button folds in the sidebar so that only the tab bar and the Unfold

button stay visible on the right side.

The Unfold Button

Enabling the Unfold button folds out the sidebar to the previous set size.

The Close Button

Pressing the Close button removes the sidebar from the program user interface.

The Dotted Line

The Dotted Line is used to move the entire sidebar. While the left mouse button is hold

down, the sidebar can be moved to any place. Double-clicking on the dotted line looses

the sidebar as well. Double-clicking on the head or moving the mouse towards the right

edge of the bar anchors the sidebar.
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The Tab Bar

Fig. 8.2-2: Tab bar with activated layer tab

The selection is done by clicking on the appropriate tab.

Note: The bar may include, depending on the program version more, less or other

than those shown tabs.
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8.3 The Layer Tab

The Sidebar is switched on or off via the Window Menu. Selection using

the Layer tab.
CTRL+2

The Layer area serves for the coloring of objects, the definition of foil colors, the selection

of objects that have a layer color, the locking and the hiding of color layers as well as the

allocation of output tools.

8.3.1 A) The Layer Area

8.3.2 B) The Layer Options

Fig. 8.3-1: The New button

This option generates a new layer an opens the corresponding dialog.

Fig. 8.3-2: The Sel(lect) button

This option selects the clicked Layer.

8.3 The Layer Tab
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8.3.3 C) The Palettes Options

Layer numbers

The activation of this option switches on or off the numbering next to to the color bar.

8.3.3.1 Layer Info Dialog

Layer Info Dialog

opens the following Setup Layer dialog.

Fig. 8.3-3: Setup Layer Dialog

When mouse over layer, show following info,

the activated information is shown in so-called Tooltip.

8.3.3 C) The Palettes Options
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In addition, the used part of color bar to this info %, number of visible layers can be

defined and the window width of the layer toolbar can be changed interactively.

8.3.3.2 Layer Order Dialog

Fig. 8.3-4: The Change Layer Order Dialog

The sequence of the layers can be changed arbitrarily. To do so, please use the up,
down, to top, to bottom button.

8.3.3.3 Only sel. layer visible

Only shows the objects that lie in teh selected layer.

8.3.3.4 Del sel. layer

The activation of this option deletes the selected layer.

Note: This option can only be activated if no objects lie in this layer, if the layer is

unused.

8.3.3.5 Delete unused layer

All layers that do not contain any objects (unused) are deleted.

8.3.3 C) The Palettes Options
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8.3.3.6 New

This option generates a new color palette.

Note: 6 base layers will always be created. Order and color can be changed anytime.

8.3.3.7 Load

Previously defined palletes can be loaded.

8.3.3.8 Save

With this instruction  a newly defined or mdoified palette is saved on your harddisk.

Note: If a new or changed palette is named 'Default', this palette is used at every

restart of GreatCut.

8.3.3.9 Save as

This instruction allows the renaming of a palette name and save the palette using the new

name.

8.3.3.10 Default (History)

This instruction loads the color palette that is delivered as standard with GreatCut. It is a

Mactac foil table.

History

This function facilitates the loading of the last color palettes. At the end of the menu list the

names of the last edited color palettes appear.

8.3.4 Status Indicator Layer

Fig. 8.3-5: Layer Statusanzeige

Object in layer color

Is a layer marked with this symbol, it means that objects are in this color or layer

assignment exists. The selection is easiest using the  button.

8.3.3 C) The Palettes Options
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Not visible layer

Is a layer marked with this symbol, it means that objects in this color or layer assignments

are not visible at present. They exist an can be switched visible if needed. In general

layers are set to invisible, if they are obstructive while designing.

Locked  layer

Is a layer marked with this symbol, it means that objects in this color or layer assignments

are locked, thus can not be edited, moved or scaled.

Layer active but not occupied

Is a layer marked with a frame, it means that no objects are available in this color or layer

assignment, but the layer is active. Now, for example, objects can be filled with that color

or contour and layer assignments can be done. The number indicates the layer number

and the depth of arrangement.

Note: The term depth of arrangement means that objects with a lower number are

drawn before those with higher numbers. The layer order also has an influence on

the drawing sequence.

Object in layer and active

Is a layer marked with a frame and this symbol, it means that the layer is active and there

are objects in that color (or layer assignments) on the desktop. The number indicates the

layer number and the depth of arrangement.

Note: The term depth of arrangement means that objects with a lower number are

drawn before those with higher numbers. The layer order also has an influence on

the drawing sequence.

8.3.4 Status Indicator Layer
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8.3.5 I. Layer SettingsOutput Setup

Fig. 8.3-6: Layer Settings dialog with toll / mode list - Output setup

8.3.5 I. Layer SettingsOutput Setup
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8.3.6 II. Layer Settings Color Setup

The following view appears after you press the color button.

Fig. 8.3-7: Layer - color, material name, color number and define properties - color setup

In the layer settings dialog the following three color models are available.

1. CMYK - Cyan, Magenta, Yellow, Kontrast

2. RGB - Red, Green, Blue

3. HSB - Hue, Saturation, Brightness

Layer button

Save

This instruction saves an additional layer containing individual settings.

Insert

Inserts a layer into the Layer toolbar.

8.3.6 II. Layer Settings Color Setup
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Delete

This instruction deletes a layer from the Layer toolbar.

Save palette

This option saves all modifications in the corresponding palette file into the pal subfolder.

Properties

Locked

Locked means that objects which are in this color layer can not be marked or selected. In

front of the locked layer appears symbolic a U-lock.

Not visible

Not visible lets disappear all objects from the desktop which are assigned to this layer. In

front of the not visible layer appears symbolic a stroked eye.

Note:  Both functions can be undone at any time by activating the layer settings

dialog using the right mouse button in the color bar. Now the resetting of properties

is possible.

Color

Material name

In the field Material name you can assign  to a color layer an individual name.

Color number

In the field color number you can enter the name associated with this type of material or

color number.

Note: The advantage of the allocation of foil name and color number is that you can
assign all materials to color layers - tailored to your stock. In designing these

materials can be taken into account so that the assignment is visible during output.
For each choice of films or types of materials a palette that is used in the design can

be stored.

Output button

The activation of the output button switches to the Output setup.

Important note: This dialog is only enabled when this option was set in the driver!

Only then the output button appears.

8.3.6 II. Layer Settings Color Setup
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Spot color

The color name that is entered in this field is written into the output file if an EPS export is

done.

Note: Often, this option is used for the definition of cutting paths, or the spot color

is treated as a special channel in Photoshop.

Palette history

This function facilitates the loading of the last color palettes. At the end of the menu list the

names of the last edited color palettes appear.

Sel button

Fig. 8.3-8: Sel(ect) button

If the sel button is pressed all objects which lie in the selected layer are marked.

8.3.7 Hotkeys in the layer processing

The following hotkeys are available in the layer processing. 

Adjacent hotkey opens the Layer Settings dialog box L

Jump in the toolbar

POS 1 key Jump to the first layer

END key Jump to the last layer

PgUp key Jump to 1/10 of the total layer number

CURSOR up / down Jump to the next layer

Color assignment via the toolbar

Double-click assigns the layer color to marked objects

Double-click + CTRL
key

assigns to marked objects a pen contour in the active layer

color

Movement of single layers / modification of the sequence

1. Step: Position mouse cursor on wanted layer

2. Step: Press left mouse button and keep pressed

3. Step: Move layer to the wanted position

4. Step: Press once right mouse button

5. Result: The layer is at the new position

8.3.7 Hotkeys in the layer processing
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8.4 The Macros Tab

The Macros tab is responsible for managing scripts for the automation of functional and

work processes - Keyword: Process Management. Here all macros are listed that are

located in the macros subfolder of the program.

8.4.1 The Macro List

The figure below shows the start view after enabling the macro tab - here: macro list only

with the number of duplicates macro.

8.4.1.1 Macro Title

Fig. 8.4-1: Icon and title resp. macro name

8.4.1.2 The Execute Button

A click on the execute button enables the selected macro. Depending on the preset the

macro is executed, either directly or there will be required additional input from the user.

Fig. 8.4-2: Macro view before processing

8.4.2 The Tool Bar Area

8.4 The Macros Tab
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8.4.2.1 The Tool Bar

Fig. 8.4-3: Closed tool bar with layer selection

The Open/Close Button

A click on the Open/Close button opens and closes the complete tool bar.

Fig. 8.4-4: Opened tool bar

8.4.2.2 Layer Selection and Assignment

The Layer Selection Button

Fig. 8.4-5: 

With this button selected objects can be related to any layer and tool (if assigned!).

The Assign Layer Button

Fig. 8.4-6: 

After clicking on the Assign Layer button the selected objects are assigned in fact to the

chosen layer.

8.4.2.3 Common Settings

After clicking on the Common Settings button the following dialog appears:

8.4.2 The Tool Bar Area
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8.4.2.3.0.1 Enable tool tips

The Enable tool tips option activates respectively deactivates the display of help texts in

the Workflow Manager

8.4.2.3.0.2 Size of run button

This option determines the size of the run button for starting the macro. Especially for

touch screens a resizing can be done.

8.4.2.3.0.3 Number of Quicklayers

This option determines how much Quick layers are displayed in the Macro tab.

8.4.2 The Tool Bar Area
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9 Tips & Tricks - Trouble Shooting

Often, it is just a bagatelle that makes the "implementation" of new software

difficult. Similar to a new machine, there are questions and problems with new software

that often can be explained and solved easily. Therefore, we have explained a selection of

questions that occur daily at our hotline- and support routine more closely.

9.1 Code is not accepted with Windows 7, 8, 10 or Vista (No
Dongle)

Error message: Invalid code or after each program start the code must
be entered again

The program must be executed once with aministrator rights. Click with the

right mouse button in the program menu on GreatCut 4 and select "Execute

as administrator".

Note: Don't change anything on the given activation data resp. license

data.

Tip 1

9.2 Buffer Overflow Serial Port

The cutter cuts the first characters neatly and then starts to draw
indefinable curves. 

With serial activation of the cutter, this is a typical buffer overflow problem

and occurs if the protocol for the serial transfer is not set correctly. Most

cutters are activated with the following parameters with a serial data

transfer: bits per second: 9600, data bits: 8, parity: none, stop bits: 1,

protocol resp. flow control: hardware

Tip 2

9.3 Computer without serial COM port

My computer provides no serial COM port, but a USB port. How can I
connect my cutting plotter, which provides only a serial interface?

In this case there is a computer accessory called - USB serial adapter-  that

provides one or more serial COM ports on one USB port.

Note: Not all adapters offered work properly, especially the use on

64-bit operating systems is sometimes not free from errors. It may be

that different adapters must be tried.

Tip 3
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9.4 Cutter Does Not Respond!

a. First check if you have selected the correct cutter driver and the correct

port: for example <device name> at COM2 in the GreatCut cutting dialog

b. COM connection: Check if the parameters of the port are set correctly. To

do so, call up the system control of Windows. In the device manager, select

the corresponding connection, for example: COM.

Popular standard parameter are: Baud: 9600, data bits: 8, parity: none, stop

bit: 1, protocol / flow control: hardware

The settings in the system control and at the cutter must be identical

otherwise no or only faulty data transfer will take place.

c. USB connection: Check if the correct USB driver is installed for the

device. The settings are in the Windows device manager under USB

controller. The USB driver for the cutting cutter must be entered in this list

otherwise no activation is possible.

If the USB driver does not appear there, install it from the delivered data

carrier of your device.

d. Original cable: Check if you use the original cable recommended by the

manufacturer. If this is not the case, there might be bigger problems during

the data transfer. GreatCut „communicates” during the data transfer with the

cutter so that missing or faulty connected data cable with the cutter lead to

input or output errors.

Tip 4

9.5 Buffer Overflow

The cutter reports „buffer overflow” or does not cut the whole job

This is often because of an incorrect setting of the used protocol of the serial

(COM) port. In most cases it is sufficient to set the protocol respective the

flow control of the port to hardware.

Tip 5

9.6 Data Import From Apple Computers

Data import from Apple computers in GreatCut

When exporting Apple data you have to pay attention to some settings to

have a perfect data export. All popular Apple compatible illustration and

graphic applications can export EPS data. (Illustrator, Freehand, …)

For the contours, as line width only hairline (0.01 mm) must be

entered.

1. 

No fillings should be transferred.2. 

All texts must be converted to graphical objects. (text in curves)3. 

Tip 6

9.4 Cutter Does Not Respond!
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Grouped or combined objects must not be available. (break up

before)

4. 

Especially with the Freehand-export the export filter for the

Illustrator-format must be selected.

5. 

As file name extension .eps should be used and you should not

use umlauts as ü, ä, ü.

6. 

9.7 Typical Sources of Errors When Cutting

a) The foil is clamped too loose

Consequence: the knive moves the foil during the cutting and the contour is

not closed completely.

Remedy: when inserting the foil pay attention that the foil is clamped evenly

and does not undulate.

b) The speed is too high

Consequence: small foil parts especially serifs and counters are

unscrewed.

Remedy: reduce speed and lower the pressure.

c) The tool pressure is too high

Consequence: the release paper is also carved, character parts are

unscrewed and parts of the release material get stuck at the characters. The

weeding of the foil gets more difficult.

Remedy: reduce pressure and correct the depth of the knife if necessary.

d) The tool pressure is too low

Consequence: foil and adhesive were only partly cut through. The weeding

is possible only with difficulty or not at all.

Remedy: increase the pressure and correct the depth of the knife if

necessary.

e) The knife is set too deep

Consequence: foil, adhesive and release material were cut. Foil cannot be

used any more.

Remedy: correct the setting of the depth of your cutting knife.

Tip 7

9.6 Data Import From Apple Computers
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f) The knife is used up

Consequence: only the foil and not the adhesive is cut through.

Indication: when using standard foil the using up of the knife is little.

When using reflection or sandblast foil the using up is much higher.

Remedy: use new original knife.

g) The characters were unscrewed

Consequence: The weeding border is possible only with difficulty. The

unscrewed parts stick to the foil and cannot be detached any more.

Generally is presumed: the smaller the font size the thinner the foil must be;

the adhesive force of the gluten is higher.

Remedy: reduce the speed and if necessary the tool pressure until this

effect does not occur any more.

h) The release paper is also cut

Consequence: the release material sticks to the foil. The weeding is

possible only with difficulty or not at all.

Remedy: correct the setting of the depths of the cutting knife and also

reduce if necessary the tool pressure.

9.8 Plotter Via USB Is Not Working!

Error message: Cannot open interface!

Check first, if your cutter is listed in the Device Manager (Control Panel /

System / Device Manager). If not, reinstall the device driver as described in

the plotter manual.

Check then, if the USB port for your cutter is selected in the GreatCut

Device Settings. You'll find the Device Settings window in the Settings /
Common Settings / Devices menu.

Note: A USB cable should be no longer than 5 m without booster.

Tip 8

9.9 The Values for Cutting Pressure And Speed Are Not
Saved

After changing the values it is often forgottten to confirm the values. Please

press the  button beside the Enter Material field and enable the Save
Material Data option.

Tip 9

9.7 Typical Sources of Errors When Cutting
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9.10 Error Message While Output into File

Error message: "Error for CreateFile"

This error message is given out, if the access right Write for the program

folder of GreatCut is not set.

Relief: Enable write rights for the program folder.

Tip 10

9.10 Error Message While Output into File
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9.10 Error Message While Output into File
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A Dictionary of Technical Terms

Active and Passive Jobs Active jobs are those that are being cut. Passive jobs are

waiting in the queue for output.

Additional Programs Additional programs are program modules or stand-alone

programs that are part of the delivery.

Auto Import Plug-Ins Auto import plug-ins are used to automatically import

data from other programs - without intermediate steps.

Automatic Contour Pen
Conversion

This feature means that before the data is transferred the

software 'looks' for objects with the attribute 'contour'. If

so, the user can decide whether the contour is to be

converted or not. If the contour should be converted, then

a vector object with the width of the contour is

automatically generated!

Bitmap Functions Bitmaps are pixel images or photos. Bitmap

functions means all functions which are not vector tools

like node editing, and which are only applicable on

bitmaps.

By Color This is a welding function, which deletes all

surfaces, which are covered by overlying colors.

Bypass Cutting Direct cutting - without window - before output on the

cutter

CMX Data Transfer CMX data transfer means the handing over of data using

CorelDRAW's CMX data format. CorelDRAW had

created this format in order to ensure the exchange of

data within the Corel program families. CMX is a public

data format and is used for the exchange of data. This

has the advantage compared to EPS, that Corel specific

types of data can be copied 1:1, without making a

conversion of the format.

Cap Height Setting Cap height is the typographical correct unit of capital

letters. The text editor uses this unit by default when

calculating the font size.

Circular Text Is a special feature of the text editor with that text

blocks can be placed on or in a circle.

Clipart Tab Cliparts are job-similar files - often logos or patterns -

which are useful for the design of an output job. The

clipart tab is a sub-tab of the Sidebar, with that the

cliparts can be managed.
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Clone This function is usually used when creating labels and

series. Changes at the control object are transferred to

all clone objects.

Close
Objects (Automatically)

When importing DXF or HPGL data, many or all objects

are not closed. On a cutter only closed objects can be

processed reasonable. This function will automatically

close all vector objects. In the basic settings the

threshold for the closing of objects can be changed.

Contour Line (Print & Cut) Unlike the outline / inline bitmaps are here provided with

a vector contour. This function is regularly needed in the

creation of labels and stickers.

Create / Edit Text Block Text blocks are blocks of text that can be used more

frequently because they appear identical or similar in

many jobs - such as your address. With the PhraseWriter

arbitrary blocks of text can be created and modified as

needed.

Cut Out Region Is a bitmap function which provides the tracing of parts of

a bitmap. You can cut out any vector form out of a

bitmap.

Device Control This section deals with device control functions on the

output side.

Digitize Mode This feature means a drawing tool, that  similar

to digitizing tablet with a magnifier, draws nodes on the

working sheet.

Dongle Protection A dongle is a hardware copy protection that is stuck on

the USB port of the computer to make run the software.

The dongle protects producers against unauthorized

copying of its software and at the same time it protects

the investment of the buyer, since its competitors do not

get the software free of charge. Thus from dongle

protection both sides benefit - producers and buyers.

Drill Holes Drill holes is a special drawing tool, that marks the

position of a drill hole, using a crosshair cursor. If the

connected machine is capable of producing drill holes,

then the position is transmitted to the device driver.
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Files Tab Is a sub-element of the Sidebar, with that Jobs can be

managed. Job is the file extension, which is used from

EuroCUT.

Flatbed Cutter All cutters that have a flatbed as a cutting surface.

Folder Monitoring This function means that the software monitors a

selected folder on hard disk or network. Every time when

a change in the monitored folder occurs - by saving or

deleting of jobs -  the thumbnail gets updated.

Fontmanager The Fontmanager manages fonts in databases. The

advantage of this method is that the database can be

copied from one computer to another and thus the same

set of fonts is available on both computers.

Full Surface Is a welding function, which underfills objects in one

color, whose surfaces overlap another. The partially

hidden objects are treated in a way, that they are

underlaying all overlying objects.

Hatching In this milling method the area, which should be

removed, is provided with a hatching. The area gets

removed along the hatching using the milling tool.

Hotfolder Management A folder can be defined as a so-called hot folder. All

output jobs that are stored in this directory are supplied

to the output.

Job Calculation The Job Calculation means a function with that

preliminary costing can be done easily. This function is

particularly well suited for calculating charges of material

costs.

Job Info The Job Info can - referring to each job - save additional

information such as order number, customer address,

material, time spent, a. s. o..

Job Rerun Any job that is still in the job history can be cut again

identically. The actual to the machine transmitted data is

stored. All parameters are given out into the output file.

Laser Engraver Name for all devices which don't use an engraving

needle but a laser unit.

 - This device type is supported by the software suite
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OptiScout. Full info at: www.optiscout.com

Layer Tab Is a sub-element of the Sidebar, with that layers can be

managed. Layers are color levels which determine and

control output order and tool parameters - besides object

position.

Material Display Each color layer can be assigned a specific material with

an exact material description. The assigned material is

displayed before the output in the Job Calculation, Job

Info and the layer itself.

Milling & Engraving This rubric lists the specific functions and tools which

were implemented for milling and engraving.

Monitor Output Process With monitoring, we mean that the output process can be

suspended, stopped and continued. Active jobs can be

switched to passive and if necessary be re-activated.

Multi Inline In this milling method the area, which should be

removed, is provided with multiple Inlines. The area gets

removed along the inlines - from outside to inside.

Multi Port Support With this we mean that all ports on a given computer -

which are suitable for the issue - can be used. Typically,

these are all COM and USB ports.

Multi User Versions
Available

For every main license multi-user version can be

purchased. The additional versions here have the same

serial number as the main license.

Multi-functional Cutter Multi-functional cutters are devices which can use

various tool heads beside a cutting tool head. They are,

for example, oscillating knives, spindles, and hemming

tools.

 - This device type is supported by the software suite

OptiScout. Full info at: www.optiscout.com

Multiple Cutting Option to cut easier thick and resistant materials

Node Editing Main tool for the creation and editing of vector objects.

Objects Tab Is an sub-element of the Sidebar with that objects can be

managed. A large number of object attributes such as
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visible / invisible, do not output, do not print, can be

individually defined for each object.

Open Trimming Is a welding function, which creates open vector objects,

after they were separated at their intersections.

Optimization Targets of the optimization are: diminishing of rejection

rate, material saving, time saving, optimization and

shortening of job preparation. The optimizing of objects

can be done on the working sheet or in the output

preview. The objects are sorted so that the material

consumption, without nesting of objects, is minimized.

Outline / Inline Outline is a special function, where vector object is

contoured automatically with a contour in a predefined

distance. In contrast to the contour line, the outline

creates - in case of internal objects - so called Inlines.

Parallel Device Output This function can simultaneously provide data on multiple

machines, which are connected to a computer, if

sufficient computing power on the PC is given.

PhotoCUT PhotoCUT is a program module which can convert

halftone drafts into vector stripes. The so generated

vector stripes can be cutted on each usual cutting plotter

and, generate - with the appropriate viewing distance -

one photo-like effect.

PhraseWriter The PhraseWriter is a program module for the

management and use of text blocks. It is automatically

started at startup and is accessible at any time using the

right mouse button context menu. The specified text

block is selected and then inserted and displayed on the

desktop.

Plot Manager The Plot Manager is a separate program module, which

'background' controls and monitors the output of the data

on the selected device.

Plot Server Function
(TCP/IP)

A computer at which multiple output devices are

connected can act as a plot server. The data transfer can

take place via the network using TCP / IP. Assuming the

appropriate licenses, any number of client computers can

give out on the plot server devices.

Plot to File The output of the plot data can be redirected to a file.

The user only has to activate the appropriate option in

the output dialog.
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Posterize Posterize is a bitmap function which performs a reduction

on any number of color hues per color layer.

Preview *.CDR and *.CMX The files tab can display besides *.JOB also contents of

*.CDR and *.CMX files (CorelDRAW formats).

Productivity Tools Productivity tools are special tools, which - because of

their workings - enhance the productivity of sign making

processes. These are usually such tools, which

distinguish a cutting software from illustration programs

such as Illustrator and CorelDRAW.

Program Type This section summarizes certain criteria which

characterize the use of the program.

Reference Job (*.JRF) In a so-called Reference Job the environment, the tool

parameters and the device drivers are stored. In this

way, it is possible to output the job in an identical manner

as many times as wished.

Register Mark Is a special drawing tool, with that marks, for the making

of multi-colored foil signages, are drawn. This register

marks can consist of a cut-through or a filled square and

are positioned by the user to the desired position on the

output job. While the output these registration marks are

always cutted at the same position on the vinyl

(layer independently), so then the precise assembly of

various colors is possible.

Roll Cutter Roll cutter means all cutting plotters, which can only

handle material rolls.

Screen Printing Is a welding function, which allows the changing of the

color stack. Thus, the order of the colored vinyls can be

re-sorted - interactively - from light to dark.

Segmentation with Overlap Segmentation is always necessary when the job is larger

i.e. longer or wider than the connected device is able to

plot. The overlap is necessary when the individual

segments are to be completed to a whole again. Joining

otherwise would lead to undesired white gaps.

Sidebar Sidebar means a movable control element that can be

made visible on the desktop. The individual sub-elements

are activated by clicking so-called 'tabs'.

Sort with Simulation In this function, all objects are sorted according to a

certain criterion. For some output devices such as lasers
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or milling machines the sequential processing of the

objects is important. Therefore, the output can be

simulated and the collation can be adapted to the

requirements of the output device.

Space (1/1, 1/2, 1/4, 1/8) Special function with that micro-typographical-correct

spaces (keyword: em quad) and thus word / letter

spacing can be generated. These special spaces can be

directly entered via the keyboard.

Spool Function When the Plot Manager is activated with the parameter

!SPOOL!, it runs independently without starting the main

program. Output data can be activated and given out via

Drag & Drop.

Spot Colors Definable Spot colors are color layers, which are defined in a way

that color values are additionally given out. Some hybrid

devices and RIPs use spot color values for the control of

output processes. When printing the corresponding color

plates are given out.

Stacking Stacking means that at first as many objects are

positioned adjacent as will fit on the material. The

following objects are then positioned above it. This

process is repeated until all objects are positioned on the

material.

Stand-alone Software "Stand-alone" means that this program can be used

without any other so-called host program. It has all the

tools that are needed for the design, layout, and the

output of jobs.

Start Tool Paths When milling and laser engraving it often happens that

immersion traces are visible at the start point of an

object. To ensure that the quality of the objects which are

milled is not affected, the start point can be laid outside

the object. This task is performed by so-called start tool

paths.

Status Display Material
Consumption

In the output preview at the bottom of the window is a

status line where the material consumption of the job is

displayed in square meters. Since this happens before

the output, this feature can also be used to order exactly

as much of a material as is required currently for the job.

Symmetrical Object This is a tool that can create stars and polygons. With it

the initial shape (circle, ellipse) and the number of edges

can be specified. With its own drawing tool then the

symmetric objects on the desktop are drawn.
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Templates (*.JTP) Templates or patterns are jobs which have no

name (untitled) when opened. Templates can always be

created if they can serve as an example for other similar

jobs. The advantage is that the working sheet and layout

are predefined.

Test Run Before the actual output a so-called test drive can be

carried out to examine whether, for example, the material

is sufficient. During the test run the raised tool head

moves along the vectors.

Text Editor Text editor means program functions that include all the

tools necessary for professional capturing and editing

texts. Typographic special tools that are essential for

signmaking were implemented.

Text Import (*.TXT, *.RTF,
*.ECT)

External texts can be imported directly into the so-called

text box, with the above formats being used. For

formatted text the RTF format must be used. It can be

saved from every professional word processing program.

Thumbnail Preview Thumbnails are small low-resolution pixel previews of file

contents. All in the selected folder located files will be -

by means of the thumbnail preview - visible and

manageable.

Tool Parametrization Means that specific settings for a tool can be done by the

user. This can be values for speed, drive, depth, angle,

pressure, acceleration or other parameters. The device

driver provides the parameter fields. The user can edit

corresponding parameter values before the output on the

device.

Tool Assignment To each color layer a specific tool can be assigned. This

makes creation and processing of jobs much easier. The

selected device driver provides all possible tools. The

assignment itself can be done by the user individually.

Track Logging For each tool the distance will be recorded. In addition,

the date, time and device names are stored.

Trimming Is a welding function, which separates closed vector

objects using lines or curves. The resulting partial objects

are re-closed then automatically.

TrueType, OpenType, Type
1, BE Fonts

These 4 font formats can be managed with the

Fontmanager i. e. add, enable and disable.
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URW BE Fonts The BE-type format was created by the company URW.

The BE-format is a vector font format that was shipped

with SIGNUS systems.

Vectorization, Tracing Vectorization means the conversion of bitmaps (pixel

images) to vector contours.

Video Marks (Print & Cut) Video marks are marks that can be detected by cutters

with optical sensors or cameras to compensate for

inaccuracies of the print result. In the print and cut

process they are used also for the contouring of print

objects.

Wait After Segment If a job has to be segmented, then the user receives this

option with the ability to re-equip the machine before the

next segment is processed. By means of a message

window the process can be continued at any time.

Weed-Ex Driver Option It is a specially laminated flex or flock material of Witpac

GmbH. First, the actual vector lines are cut. In the

second step, the components that need to be weeded,

are cut out in a way, that they 'fall out' automatically at

the end. So you have already reached the entire plot

result after peeling off the medium and you don't have

to weed manually.

Weeding Lines horiz. / vert. In addition to the global weeding frame, which is

generated around the entire output job, individual

weeding lines can be added horizontally or vertically in

the output preview. Large, bulky jobs can thus be

divided.

Welding Welding functions are needed for the treatment of

overlapping of layers or vinyls. These functions are in the

signmaking and screen printing department essential for

the processing of vinyls.
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B Glossary

Additive color system The ~ is based on mixing the additive, luminous spectral colors

red, green and blue (RGB), for example in color TVs or color

monitors

Adjustment Modification of the distance between two adjacent characters

so that a harmonic type face is being created. This is reached

by correcting the character - or word distance.  With distances

below 100% you speak of kerning and with values above 100%

of spacing out.

Adjustment handles ~ are the 9 black squares that are drawn around the object and

in the middle when marking objects.

Antialiasing Edge smoothing with bitmaps

Application tape Foil that is used to apply the cut foil after the weeding on the

lettering area. The adhesive force must be strong enough so

that the text - even the tiniest letters - can be released from the

substrate without problems. After application, the ~ must also

be released without problems. 

Ascender Term for the part of a character that extends above the middle

length.

Backup Data backup

Bit-depth also shade ~ is the mathematically possible number of colors with a

specific number of bits, for example:

1 bit color depth = 21 = 2 possible colors (black/white)

8 bit color depth = 28 = 256 possible colors/shades of gray

24 bit color depth = 224 = 16.8 millions possible colors

Bitmap Pixel-graphic

Bold Font that a bit thicker than the standard typeface.

Byte Smallest addressable unit in the computer memory, consisting

of 8 bits.

Calibration Adaptation of printer, monitor, cutter or adaptation to desired

values.

Cap height This is the height of the capital letters, the capitals. As

measurement usually the height of the letter „H” from the font

line to the top edge of the character is used.

Center justification A break justification where the text block is justified at the same

time on the left and on the right side. To do this, the word

space within a text line is varied (usually extended) so that on
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the left and right side a clean text edge is created. This is not

only applied for the the last line of a break.

compare also: forced block

Clipart(s) ~ are jobs or job parts that were added to the Clipart toolbar .

They are saved in a separate directory. (C:\Program

Files\GCC\GreatCut 4\CLIP)

Clipboard ~ is used for temporary storage in Windows.

The ~ is used to exchange data fast between applications. 

CMYK Cyan, magenta, yellow, contrast (key, black) Standard colors

for the four-color printing.

CMYK-color area ~ is the total number of colors that can be displayed by the

colors used when printing (CMYK).

Color depth ~ is the number of possible color tones that can be recognized

by a scanner or reproduced on a color monitor.

Container A container - more exactly an image or text container - is a

vector object, that similar to a real container can take up

arbitrary image data or texts. In conjunction with macro scripts

contents can be exchanged semi-automatically or

automatically.

Context menu Context menus are called so because the structure adapts and

changes depending on the number and type of the selected

objects (context). Context menus are always activated with the

right mouse button. They serve for the faster access to

important functions and tools and also to those functions that

cannot be activated via the main menu.

Contrast Contrast; range of brightness between bright and dark parts of

a picture.

Cursor ~ is the blinking, vertical line in an editable field.

Decoration Accentuation of text parts by modification of the text attributes,

for example bold, italic.

Descender This is the part of a character that protrudes below the font line.

Desktop The area besides the working surface that can be used for the

draft. It is comparable to a desk on which are the tools.

Digitalization Conversion of a picture template into a digital form. The

capture is done point for point or line by line by means of a

digitalization tablet or by reading the template with a scanner.

Dongle
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Means the copyright that is part of the scope of delivery of

GreatCut. It is inserted in the USB interface of your computer.

Without ~ the software cannot be started.

Download Downloading applications or files from the internet to your

computer.

DPI Acronym for Dots Per Inch; resolution fineness (1 inch = 2.54

cm)

EPS Acronym for „Encapsulated Postscript Format”. In this file

format the text and picture information is saved in the page

description language postscript. This format also contains

besides text and raster data also a preview bitmap which

allows displaying a copy of the data on the screen.

Foil Two production processes are common: calendaring and

casting. Cast foil is created without drawing frame and thus has

a lesser shrinking tendency. The costs are usually higher than

with calendared foil. Calendared is cheaper, has a shorter

period of usage and shrinks more.

Cutting foils are built in three layers:

1. Substrate; the lowest layer

2. Gluten layer; is between the foil and the substrate

3. the foil itself.

Font Type cut within a type face in digital form. Most type faces

have the fonts normal, bold, italic and bold-italic. Often, the font

is used for the same type face. Correct would be that each cut

is a separate font.

Font line ~ is a thought line on which the characters of a row are

standing. Even if different font types and font sizes are used

in a row, all characters must stand on a common font line.

Font size ~ is the size of a font. It corresponds to the block height, which

means it also comprises the ascender and descender as well

as a certain space above and below the characters. 

Forced justification Justification where all text lines - also the last- are adapted to

the width of the column or the working area. In GreatCut this

justification is called „force justification”.

Gamma correction The ~ is a method for the correction of color graduation

considering the perception of the human eye if there are two

adjoining areas of different color.

Group Combination of arbitrarily many objects to a group. The

position of the objects itself does not change any more within

the group.
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Halftone image(s)  ~ are pictures which contain shades of gray or hues. The tonal

value between pure white and pure black is called halftone.

Hotfolder A Hotfolder is a directory monitored by the Plot-Manager. If a

file is copied into this directory, the Plot-Manager carries out

automatically specific configurable functions.

Inch Measurement unit for the length

1 Inch = 2.54 cm

Job File-ending of GreatCut; name for GreatCut file

Justification Alignment of a text block on the working area. GreatCut offers

justification left-aligned, right-aligned, centered, center

justification, forced center justification and adjust cap height.

Kerning If two characters stand closer together than it would

correspond to their standard thickness, you speak of ~. With

character combinations as for example „Te” you have a

balanced type face.

Laminating Covering with transparent plastic films.

Live-Update Updating of software via the internet.

Macro A ~ automates program flows. The automation can thereby be

realized with the program's own commands or a macro

language.

Marking function ~ means marking objects by keeping pressed the left mouse

button, then drawing a frame around the objects to be marked

and letting go the mouse button only if all objects to be marked

are completely within the frame. 

Process colors Printing scale of colors for four-color-printing with cyan, yellow,

magenta and black (key). By mixing these colors, it is possible

to print all colors.

Profile The appearance of program surfaces is called ~. The shown

tools and menu items can be individually adjusted to the

user. Intention is to simplify the user interface.

Raster Image Processor short: RIP - Software that rasterizes vector data and controls

the printing on a large format printer.

Resolution Number of pixels per track unit. It is indicated in dpi (dots per

inch). Laser printers have a resolution from 600 to 1200 dpi.

Scan resolution Fineness of the resolution when scanning analogue images

Formula:
Resolution (in DPI) = printing length (L/cm) x 2 (quality factor) x
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enlargement factor x 2.54 (when converting from cm into inch)

Subsidiary line These are lines for the virtual alignment of objects on the

working area or the desktop. Subsidiary lines are only visible

on the monitor are neither plotted nor output on the printer.

Superscript The characters are set higher than the characters standing on

the baseline. They usually have a bit smaller font size than the

basic font.

Toolbar can be freely moved and positioned on the working area of an

application. Often, also the composition of the tools can be

defined.

Trapping A small overlapping zone at the limit of superposed colored

elements. This ~ guaranteed that no white gaps occur at the

color borders. The overlapping can happen through overfilling

or underfilling.

Upload Upload is the sending of files or applications to a networked

server

Weeding means the removal of unnecessary foil parts after the cutting

with a cutting plotter. 

White gaps ~ are the gaps on the edges of overlapping or abutting color or

foil areas. Disadvantageous especially with silk-screens or

when printing.

x-height Height of the lower case/character „x” respective the lower

case without the ascender of a font.
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